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1. Установка и лицензирование Zeno Field и Zeno Connect 
 

Эта глава расскажет Вам как установить и лицензировать Zeno Field и Zeno Connect. 

Первая часть о CS10/15, вторая часть о CS25, и третья о Zeno 5. 

1.1 Установка на CS10 и CS15 
 

1.1.1 Установка Zeno Field 

 

Шаг Действие 
1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 

последнюю версию установщика Zeno Field. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Field 

2 Скопируйте Leica ZenoField.ARM.CAB в Zeno 10/15 в папку Program Files и 
дважды кликните его. 

3 Leica ZenoField.ARM.CAB запустит установку. 

 

1.1.2 Установка Zeno Connect 

 

Шаг Действие 

1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 
последнюю версию установщика Zeno Connect. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Connect 

2 Скопируйте Leica ZenoConnect.ARM.CAB в Zeno 10/15 в папку Program 
Files и дважды кликните его. 

3 Leica ZenoConnect.ARM.CAB запустит установку. 

 

1.1.3 Лицензирование Zeno Field или Zeno Connect 

 

Для использования Zeno Field и Zeno Connect требуется действующая 

лицензия.  

В Licenses Manager Вы можете зарегистрировать лицензии для: 

 Zeno Field: лицензия Zeno Field, ключ Zeno GIS, ключ CCP 

 Zeno Connect: лицензия Zeno Connect, ключ Zeno GIS, ключ CCP 

 GS05/06: добавить лицензии GPS+Glonass в GS05/06 

Все Zeno устройства поставляются с предварительно установленными 

лицензионными ключами. Кроме того, Вы получите ключи в 

печатном виде. В некоторых случаях необходимо зарегистрировать 

новые лицензионные ключи, например, если ключ для лицензии ССР 

истекла. 
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Как зарегистрировать лицензию для Zeno Field 

 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 10/15 нажав Start > Programs > 
Zeno Tools > License Manager 

2 Введите ваши лицензионные ключи в соответствующие поля в закладке 
Zeno Field. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии. Это автоматически заполнит все 
включенные ключи автоматически. Это: 

Zeno GIS Key: допускает работу контроллеров CS 10/15 с Zeno Field 
Zeno Field Key: лицензия для Zeno Field 
Zeno Connect Key: лицензия для Zeno Connect 
CCP Key: ключ поддержки Zeno Field 
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Как зарегистрировать лицензию для Zeno Connect 

 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 10/15 нажав Start > Programs > 
Zeno Tools > License Manager 

2 Введите ваши лицензионные ключи в соответствующие поля в закладке 
Zeno Connect. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии. Это автоматически заполнит все 
включенные ключи автоматически. Это: 

Zeno GIS Key: допускает работу контроллеров CS 10/15 с Zeno 
Connect 
Zeno Connect Key: лицензия для Zeno Connect 
CCP Key: ключ поддержки Zeno Connect 

 

 
Лицензии Zeno Field для GNSS насадок GS05/06 
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Имеются два типа лицензий для GNSS насадок, которые пользователь 

может запросить при заказе продукта: 

a. только GPS 

b. GPS и GLONASS 

 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 10/15 нажав Start > Programs > 
Zeno Tools > License Manager 

2 Выберите закладку GS05/06 и введите ваши лицензионные ключи в 
соответствующие поля. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии.  Это автоматически заполнит все 
включенные ключи автоматически. 
 

 
 

Опция Glonass для Smart Antenna GG02 plus  

 

В License Manager вы также можете добавить опцию Glonass для 

GG02 plus. 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 10/15 нажав Start > Programs > 
Zeno Tools > License Manager 

2 Выберите закладку GG02 plus  и введите ваш Glonass ключ в 
соответствующее поле. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии.  Это автоматически заполнит все 
включенные ключи автоматически. 
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1.1.4 Установка языковых пакетов 

 

1.1.4.1 Установка языковых пакетов для Zeno Field 

 

Пожалуйста, запомните: Языковой патч Zeno Field основан на 

конкретной версии Zeno Field. Это означает, что языковой пакет 

может быть установлен только на соответствующую версию. 

 

Шаг Действие 

1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 
последнюю версию языкового пакета Zeno Field. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Field. Скопируйте его в Zeno 10/15. 

2 Дважды кликните этот файл. 

3 Языковой патч Zeno Field запустит установку. 

 

1.1.4.1 Установка языковых пакетов для Zeno Connect  

 

Пожалуйста, запомните: Языковой патч Zeno Connect основан на 

конкретной версии Zeno Connect. Это означает, что языковой пакет 

может быть установлен только на соответствующую версию. 

 

Шаг Действие 

1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 
последнюю версию языкового пакета Zeno Connect. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Connect. Скопируйте его в Zeno 10/15. 
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2 Дважды кликните этот файл. 

3 Языковой патч Zeno Connect запустит установку. 

 

1.1.5 Установка новой версии Windows CE6 
 

Есть два пути как обновить WinCE 6 на Zeno 10/15. Software Loader это стандартный 

инструмент для обновления системы WinCE 6. Альтернативный путь обновления 

программного обеспечения с SD карты прямо при запуске. Оба метода описываются 

ниже. Пожалуйста, запомните что после установки новой версии WinCE 6, другие 

установленные приложения, такие как Zeno Field или Zeno Connect, нужно 

переустановить. 

 

Обновление WinCE 6 с помощью Software Loader 

 

Шаг Действие 

1 Загрузите последнюю версию WinCE только из myWorld и скопируйте на 
SD карту. Вставьте SD карту в SD слот устройства Zeno 10/15. 

2 Дважды кликните  ярлык Loader.exe с вашего рабочего стола. Иначе 

убедитесь что нет скрытых файлов и пройдите в My Device  Windows 
 Loader.exe  

3 Найдите прошивку. 

 

 

Обновления WinCE6 при запуске 

 

Шаг Действие 

1 Загрузите последнюю версию WinCE только из myWorld 

2 Создайте директорию с именем “System” на SD карте 

3 Скопируйте прошивку на SD карту и переименуйте ее в software.img 

4 Вставьте SD карту в SD слот устройства Zeno 10/15 

5 Перезапустите устройство 

6 Zeno 10/15 будет перезапускаться несколько раз пока не закончится 
обновление программного обеспечения. Не прерывайте обновления и 
убедитесь что заряд батареи достаточен. 
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1.2 Установка на CS25 

1.2.1 Пошаговая установка и лицензирование 

 

Требования к установке 

Для установки пакета программного обеспечения на PC и 

активирования лицензий необходимо следующее: 

 PC с подключением к интернет. 

 Инвойс, накладная или Entitlement Certificate с Entitlement ID для 

пакета программного обеспечения. 

 Загруженная программа установки пакета программного 

обеспечения. 

Вы можете найти ее в myWorld: мои Загрузки  Программное 

обеспечение 

 

Мастер установки 

Установка программного обеспечения и активация пакета 

программного обеспечения делается мастером установки, 

автоматически проводящем пользователя через полную установку и 

процесс активации. Следующая глава разъясняет эти шаги установки 

в деталях. 

Пожалуйста, запомните, шаги установки и скриншоты в этом 

руководстве взяты из пакета программного обеспечения Leica Zeno 

Field. Для установки Zeno Connect это может иметь немного отличий.  

 

Шаг 1: Запуск 
установочной 

программы 

Для начала установки пакета программного обеспечения: 
 Запустите Setup.exe с локального жесткого диска. 

Шаг 2: 
Установка 

необходимых 
компонентов 

Установочная программа 
автоматически проверит 
наличие необходимых 
компонентов. 
Если установлены не все: 

 Выберите «Install» 
для установки их и они 
установятся на компьютер., 
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Шаг 3: Запуск 
установки 

пакета 
программного 
обеспечения 

Мастер установки пакета 
программного 
обеспечения запущен: 

 Выберите «Next» 
для запуска установки 
пакета программного 
обеспечения. 

Шаг 4: 
Принятие 

лицензионного 
соглашения 

Условия в лицензионном 
соглашении программного 
обеспечения Leica 
Geosystems должны быть 
приняты до того как 
программа будет 
установлена: 

 Прочитайте 
лицензионное соглашение 
и выберите «I accept…» 

 Выберите «Next» 
для продолжения 
установки.  
 
 

Шаг 5: Запуск 
мастера 

активации 
лицензии 

Для активирования вашего 
права будет запущен 
мастер активации 
лицензии: 

 Нажмите «Next» 
для запуска  мастер 
активации лицензии. 

 Отметье «Skip 
License Activation» если Вы 
уже лицензировали 
предыдущие Zeno 
Field/Zeno Connect или 
намереваетесь 
лицензировать это позже в 
License Administrator. 
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Шаг 6: Запуск 
процесса 

активации 
лицензии 

 Процесс активации 
лицензии будет запущен: 

 Нажмите «Next» 
для запуска процесса 
активации лицензии. 

 Если соединение с 
интернетом не может быть 
установлено будет показана 
страница Proxy Server. 

Шаг 7: 
Проверка 

существующих 
прав на 

лицензии 

Если для продукта, который Вы устанавливаете, лицензия уже активирована до его 
подключения к  серверу лицензий Leica Geosystems сейчас подключается для 
проверки доступных обновлений для вашего продукта: 

 Выберите «Next» 
для установки соединения к 
серверу лицензий Leica 
Geosystems. 

 Пожалуйста, 

подождие пока проверка 
завершится. (Если интернет 
подключение медленное 
это может занять несколько 
минут.) 

 Если соединение с 
интернетом не может быть 
установлено будет показана 
страница Proxy Server.  

Шаг 8: Ввод  
Entitlement ID 

Если для продукта который вы устанавливаете лицензия никогда не была 
активирована до этого то Вас попросят ввести ваш Entitlement ID: 

 Введите полный 
Entitlement ID как 
напечатано в инвойсе, 
накладной иои в Entitlement 
Certificate. 

 Выберите «Next» 
для активации.  

Шаг 9: 
Регистрация 

Рекомендуется зарегистрировать продукт на веб портале myWorld. 
 Выберите «Yes, I would like to register» если хотетите зарегистрировать ID 

немедленно. 
 Выберите «Next». 

Будет запущен браузер со стартовой страницей myWorld. Для деталей как 
зарегистрировать продукт обратитесь к пункту 1.2.2 Регистрация лицензии в 
myWorld. 
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Если выбрано «No, I don’t 
want to register» то 
зарегистрировать продукт 
можно позже. Обратитесь к 
пукту 1.2.2 Регистрация 
лицензии в myWorld. 

Шаг 10: 
Активация 
завершена 

Продукт успешно активирован и обновлен: 
 Выберите «Finish» чтобы закрыть мастер активации лицензии. 

Мастер активации лицензии 
будет закрыт и установка 
пакета программного 
обеспечения продолжится. 
Активированный продукт 
можно посмотреть в любое 
время в License Management 
Tool - CLM Administrator.  

Шаг 11: Выбор 
директории 

для установки 

Сейчас будет выбрана директория для установки пакета программного 
обеспечения: 

 Выберите «Change» 
если вы хотеите установить 
программное обеспечение в 
другую директорию. 

 Выберите «Next» 
для продолжения установки.  

Шаг 12: 
Установка 

программного 
обеспечения 

Установка программного обеспечения сейчас может быть запущена: 
 Выберите «Install» для запуска установки программного обеспечения. 
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Программное обеспечение установится в выбранную директорию.  

 
 
 
 
 
 
 

Шаг 13: 
Установка 
завершена 

После успешного завершения установки программного обеспечения: 
 Выберите «Finish» для выхода из мастера установки и для запуска 

программного продукта. 
Сейчас программное 
обеспечение 
установлено и 
заказанная лицензия 
активирована.  
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1.2.2 Регистрация лицензии в myWorld 

 

Введение 

Регистрация лицензии на веб-портале MyWorld требуется для 

предоставления доступа к соответствующей информации о продукте 

и обновлениям программного обеспечения. Для регистрации 

лицензии требуется  Entitlement ID. 

Регистрация лицензии может быть произведена как в процессе 

установки,  так и на более позднем этапе. 

 

Запуск myWorld 

 

myWorld можно открыть следующей ссылкой: 

 http://myworld.leica-geosystems.com 

 Если во время инсталляции было выбрано «Yes, I would like to 

register», myWorld автоматически откроется в отдельном окне 

браузера. 

 myWorld может быть открыт прямо из CLM Administrator если 

выбрать Register Entitlement, потом выбрать View installed licenses и 

затем Return Licenses. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Если у Вас уже есть логин и пароль для myWorld то можете сразу 

войти: 

 Введите E-Mail и пароль, и выберите Log on. 

Если у Вас нет логина и пароля для myWorld, то необходимо 

зарегистрироваться как новый пользователь myWorld: 
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 Выберите Register для запуска мастера регистрации для 

myWorld. 

 Следуйте инструкциям до завершения и Вы получите ваш 

логин и пароль по электронной почте. 

 Введите E-Mail и пароль и нажмите Log on. 

Запуск myProducts 

Регистрация лицензии на вашего пользователя (т.е. компанию) 

делается через меню myProducts (мои Продукты). Для открытия  

myProducts: 

 Выберите myProducts в меню слева. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add Product 

myProducts показывает все продукты Leica Geosystems 

зарегистрированные с текущим пользователем. Для добавления 

дополнительного продукта или лицензии: 

 Нажмите кнопку Add Product расположенную ниже списка 

продуктов и лицензий. 
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Регистрация лицензии 

 

 

 

 

 

 

 

 

Для добавления лицензии: 

 Выберите Software. 

 Введите Entitlement ID. 

 Кликните OK. 

Лицензия зарегистрируется и пакет программного обеспечения 

будет добавлен в список myProducts. 
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1.2.3 Управление лицензиями 

 

 Введение 

Управление лицензиями на CS25 происходит через диалог «View 

Licenses» с отдельным CLM Administrator Tool. 

 

Открытие «CLM Administrator» 

Для открытия CLM 

Administrator: 

 Выберите 

меню Startu > All Programs > 

Leica Geosystems > Client 

License Manager > License 

Administrator 

 

 

 

 

 

 

 

1.2.3.1 Просмотр лицензий 

 

Введение 

Просмотр активированных лицензий на CS25 делается через диалог 

«View installed Licenses»  в License Administrator. Для просмотра 

текущих активированных лицензий подключение к интернет не 

требуется.  

Просмотр лицензий 

Диалог «View Licenses» показывает Entitlement ID и все текущие 

активированные опции пакета программного обеспечения. 
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1.2.3.2 Обновление лицензий 

Введение 

Активация дополнительно заказанных опций программного 

обеспечения или технической поддержки называется «Checking for 

Updates». Обновление лицензий делается через диалог «View 

Licenses» в License Administrator. 

Для функционирования требуется подключение к интернет для 

доступа к Leica Geosystems License Server. 

Проверка обновлений лицензий 

 
Для обновления новых заказанных опций или технической 

поддержки программного обеспечения: 

 Пройдите в «View Licenses» 

 Убедитесь что компьютер подключен к интернет. 

 Выберите «Check for updates» справа снизу. 
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Обновление лицензий 

Установится подключение к Leica Geosystems License Server и 

проверит обновления для инициированных лицензий. 

 Если обновлений для лицензий нет, то Вы получите 

сообщение: «No new licenses are available» и будет 

предложено подтвердить нажатием OK. 

 Если обновления лицензий доступны Вам будет сообщено 

«xxx newly available activatable licenses.» и будет предложено 

выбрать Activate new licenses справа снизу на сайте. 

1.2.3.3 Рехостинг лицензий 

 

Введение 

Рехостинг (перемещение лицензии с одного компьютера на другой) 

может также делаться в License Administrator. 

Для рехостинга требуется чтобы лицензия была зарегистрирована на 

веб портале клиентов myWorld.  Более подробно см. главу 2.2 

Registering the License at myWorld. 

 

CLM Administrator 

 
Вернуть лицензии для рехостинга: 

 Запустите CLM Administrator. 

 Убедитесь что компьютер подключен к инетернет. 

 Выберите «View installed Licenses». 
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Возвращение лицензий 

 
Вам отобразятся текущие активированные продукты. Чтобы вернуть 

их для рехостинга: 

 Выберите Entitlement ID нужного продукта, который нужно 

вернуть. 

 Выберите «Return Licenses». 

 

Подтверждение возвращения лицензий 

 
Выбранные лицензии для возврата будут отображаться: 

 Выберите «Continue» для подтверждения возврата 

выбранных лицензий. 

 Если лицензии не зарегистрированы ещё в myWorld выберите 

Register Entitlements. (см. 2.2 Registering the License at 

myWorld) 

Подключение  к Leica Geosystems License Server установится, и 

выбранные лицензии будут возвращены. 
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Установка и активация лицензий на разных компьютерах 

Для завершения процесса рехостинга необходимы следующие 

действия: 

 На разных компьютерах следуйте полному процессу 

Installation & Activation как описано в главе 2.1 Step by step 

installation and licensing 
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1.2.4 Установка языковых пакетов 

1.2.4.1 Установка языковых пакетов для Zeno Field 

Запомните: Языковой патч Zeno Field основан на конкретной версии 

Zeno Field. Это означает, что языковой пакет может быть установлен 

только на соответствующую версию. 

Шаг Действие 

1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 
последнюю версию языкового пакета Zeno Field. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Field. Скопируйте его в ваш CS25. 

2 Дважды кликните этот файл. 

3 Следуйте инструкциям в мастере установки. 

1.2.4.2 Установка языковых пакетов для Zeno Connect 

Запомните: Языковой патч Zeno Connect основан на конкретной 

версии Zeno Connect. Это означает, что языковой пакет может быть 

установлен только на соответствующую версию. 

 

Шаг Действие 

1 В Leica myWorld (myworld.leica-geosystems.com), Вы можете загрузить 
последнюю версию языкового пакета Zeno Connect. Найти его можно по 
следующему пути: мои Загрузки Программное обеспечение 
Zeno Connect. Скопируйте его в ваш CS25. 

2 Дважды кликните этот файл. 

3 Следуйте инструкциям в мастере установки. 
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1.3  Установка на Zeno 5 

1.3.1 Установка Windows Mobile Embedded Professional 6.5 

 

Установка Windows 

Шаг Действие 

 Релиз Windows Embedded Handheld 6.5 уже предустановлен на 
английском. Следуйте этой главе только для установки операционной 
системы на другом языке.  

1 Перед использованием убедитесь, что батарея полностью заряжена. 

2 Присоедините модуль SnapOn к вашему Zeno 5. 

3 Подключите адаптер «microUSB в USB». 

 
4 Включите Zeno 5. 

5 После загрузки Zeno 5 подключите карту памяти USB (Leica Zeno USB). 

6 Выберите вашу страну на экране. Это повлияет на устанавливаемый 
язык.  

7 Вам представится меню установки.  

 
8 Выберите Windows Embedded Handheld 6.5 

 
Следуйте установке Windows Mobile 6.5, Zeno 5 будет перезагружен 
несколько раз. Пожалуйста, не прекращайте процесс установки.  

9 После окончания установки отключите карту памяти Leica Zeno USB. 

 
Для повторного входа в меню загрузчика USB просто вставьте карту 
памяти заново. 
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1.3.2 Установка Zeno Field/Zeno Connect 

Шаг Действие 

1 Перед использованием убедитесь, что батарея полностью заряжена. 

2 Присоедините модуль SnapOn к вашему Zeno 5. 

3 Подключите адаптер «microUSB в USB». 

 
4 Включите Zeno 5. 

5 После загрузки Zeno 5 подключите карту памяти USB (Leica Zeno USB). 

6 Выберите вашу страну на экране. Это повлияет на устанавливаемый 
язык.  

7 Вам представится меню установки.  

 

8 Выберите Zeno Field или Zeno Connect. 

9 После окончания установки отключите карту памяти Leica Zeno USB. 

 
Для повторного входа в меню загрузчика USB просто вставьте карту 
памяти заново. 

 

1.3.3 Лицензирование  

 

Лицензирование Zeno Field или Zeno Connect 

Для использования Zeno Field и Zeno Connect требуется 

действительная лицензия.  

В Licenses Manager (Zeno Tools) Вы можете зарегистрировать 

лицензии для: 

 Zeno Field: лицензия Zeno Field, ключ CCP 

 Zeno Connect: лицензия Zeno Connect 

 GG02 plus: опция Glonass 
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Как зарегистрировать лицензию для Zeno Field 

 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 5 кликнув иконку Windows > 
Zeno Tools > License Manager 

2 Введите ваши лицензионные ключи в соответствующие поля в закладке 
Zeno Field. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии. Это автоматически заполнит все 
включенные ключи автоматически. Это: 

Zeno Field Key: лицензия для Zeno Field 
Zeno Connect Key: лицензия для Zeno Connect 
CCP Key: ключ поддержки Zeno Field 
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Как зарегистрировать лицензию для Zeno Connect 

 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 5 кликнув иконку Windows > 
Zeno Tools > License Manager 

2 Введите ваши лицензионные ключи в соответствующие поля в закладке 
Zeno Connect. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии. Это автоматически заполнит все 
включенные ключи автоматически. Это: 

Zeno Connect Key: лицензия для Zeno Connect 
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Опция Glonass для Smart Antenna GG02 plus  

 

В License Manager вы также можете добавить опцию Glonass для 

GG02 plus. 

Шаг Действие 

1 Запустите License Manager на вашем Zeno 5 кликнув иконку Windows > 
Zeno Tools > License Manager 

2 Выберите закладку GG02 plus  и введите ваш Glonass ключ в 
соответствующее поле. Или можете нажать кнопку «Browse …» и указать 
расположение файла лицензии.  Это автоматически заполнит все 
включенные ключи автоматически. 
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2. Создание проекта 
Эта глава пошагово покажет как создать новый проект в Zeno Office и Zeno Field. 

 

Leica Zeno Office 

Leica Zeno Office и Leica Zeno Office в ArcGIS™ представляет набор 

инструментов для управления и обработке GNSS и геодезических 

данных с ArcGIS Desktop, все в привычной среде. Leica Zeno Office это 

пакет программного обеспечения для поддержки, управления и пост-

обработки GIS, GNSS и геодезических данных. С Leica Zeno GIS Вы 

можете сделать гораздо больше в напряженный день и можете 

полностью доверять точности ваших GNSS данных. 

 

 Автоматизация рабочих процессов: EasyIn и EasyOut 

 Сохранение детальной информации GNSS качества в базе 

данных ГИС 

 Интеграция геодезических измерений в базе данных ГИС  

 Эта глава пошагово покажет Вам как создать новый проект в Zeno 
Office и как передать его в Zeno Field. 
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2.1 Создание проекта в Zeno Office 

2.1.1 Мастер проекта 

Мастер проекта (Project Wizard) позволяет легко создавать новые 

проекты в Zeno Office. С мастером проекта Вы можете: 

 Указать систему координат и трансформации 

 Указать модель данных 

Шаг Действие 

1 Запустите Zeno Office или Zeno Office в ArcGIS. 

2 Откройте File > New Project и введите имя проекта. Если меню New 
Project (Новый проект) нет в меню File (Файл), пожалуйста, добавьте его 
через диалог Customize (Настройки). 

 
 

3 Выберите File Geodatabases или Personal Geodatabases как тип базы 
дынных (Database Type). 

 
Personal Geodatabases: 

 Используется одним пользователем, работающим с маленькой 
базой данных ГИС  

 Основана на отдельном файле.mdb формата Microsoft Access  
 Максимальный размер файла 2 Гб 
 Нет многопользовательского редактирования, управления 

версиями, или архивирования с сохранением истории 
изменения 

File Geodatabases: 
 Используется одним пользователем, работающим с 

небольшими и средними размеров баз данных ГИС  
 Сохраняется в файловой системе 
 Нет предела размеру (1 Тб  на таблицу (по умолчанию)) 
 Улучшенная производительность по сравнению с Personal 

Geodatabases 
 Векторные данные могут быть сжаты в формат только для 

чтения для лучшей производительности базы геоданных 
 Поддержка нескольких одновременно редакторов (при 

редактировании разных таблиц, классов, или характеристик 



 

Zeno GIS 
Быстрый старт 32  

набора данных). 
 Нет управления версиями, или архивирования с сохранением 

истории изменения 
 Рекомендуется для пользователей, которые будут запускать 

новые ГИС проекты для их локального использования 

4 Укажите путь к проекту. 

5 Впишите некоторое описание проекта, например имя геодезиста, 
расположение и т.д. (опционально) и нажмите Next. 

 
Укажите шаблон карты если Вы хотите использовать схему другого 
проекта (опционально). 

6 Нажмите Select (Выбор) для указания координатной системы. 

 
 

7 Нажмите Add (Добавить). 

8 Нажмите Next (Следующий). 

9 Настройте свойства Survey Package через кнопку Settings (Настройки) - 
опционально. 
В настройках Leica GNSS Data Model Вы можете указать:  

 Трансформацию 
 Модель геоида 
 CSCS (Country Specific Coordinate System) 
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10 Выберите Leica GNSS Data Model и кликните Settings… (Настройки)  

11 Кликните Select… (Выбор) в закладке Transformation (Трансформация) 
чтобы выбрать настройки трансформации. 

 
 

12 В зависимости от вашей системы координат, некоторые 
предопределенные преобразования уже имеются. Вы можете выбрать 
одну из них или кликните Modify (Изменить) для настройки параметров 
преобразования. 
Вы также можете создать совершенно новые преобразования, нажав 
кнопку New ... 
 

 
 

13 Отредактируйте параметры трансформации, заполнив имя и описание 
(опционально). 
Вы можете выбрать между разными методами трансформации. В Zeno 
Office, начиная с версии 3.0, включены следующие типы:  

 Leica Bursa-Wolf (7 параметров) 
 Leica Molodensky-Badekas (10 параметров) 

 
Дополнительно Вы можете выбрать геоид или файл CSCS, отметив 
далее флажком «Use Geoid file» или «Use Grid File: Leica CSCS», и указав 
расположение файла. 
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 
Начиная с Zeno Office 3.0 и Zeno Field 3.0, файлы геоида и CSCS 
поддерживаются напрямую в Zeno Office и Zeno Field. Они будут 
переданы и автоматически применены к мобильному устройству через 
EasyOut. 

 
Все клиенты кто использовали другие методы трансформации систем 
координат, радиус-вектора или  геоцентрических переводов, теперь 
придется использовать преобразования «Leica Bursa-Wolf». 

 
Преобразования готовых проектов будут автоматически ковертированы 
в «Leica Bursa-Wolf» и будут выдавать те же результаты.  

14 Нажмите OK. 

15 Установите трансформацию по умолчанию (опционально). Когда 
трансформация установлена по умолчанию (символ *) он будет 
автоматически использоваться с этой координатной системой в 
Мастере создания проектов в следующий раз. 

 
 

16 Нажмите OK для входа в окно Leica GNSS Data Model снова. 

17 Нажмите ОК для возврата в окно Survey Packages. Ваши преобразования 
указаны, и Вы можете продолжить шаги в мастере проекта. 
Нажмите Next. 

18 В следующем окне Вы можете импортировать или создать новые 
Feature Classes. 
Кликните в первом пустом имени поля Name и введите имя функции 
класса. Вы также можете импортировать схему ваших данных, кликнув 
кнопку Import. 
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19 Добавьте описание ваших классов в поле Alias Name (опционально). 

Введите больше классов объектов, дважды щелкните по полю Geometry 
и выберите нужный тип геометрии, например, Point (точка), Polyline 
(полилинии) или Polygon (полигона). 

 
 

20 Отметьте флажком чек-боксы 3D для сохранения значений высоты в 
объектах. 
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21 Для редактирования полей атрибутов классов кликните на первой 
колонке для выбора. Затем щелчком правой клавиши по выбранной 
колонке выберите Edit Attributes (Редактирование атрибутов). 

 
 

22 Введите имя поля в следующую свободную линию. Кликните поле Data 
Type (Тип данных) и укажите тип данных, например, текст, растровое 
изображение и т.д.  
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 
Для того, чтобы хранить фотографии в качестве атрибута в ваших 
данных, вы должны создать текстовое поле. В этом текстовом поле 
будет сохранена ссылка на изображение. 
Просто назовите текстовое поле "photo", "image" или "picture" и дайте 
ему минимальную длину 20 символов. 
Это текстовое поле будет автоматически использоваться для хранения 
ссылки на картинку в Zeno Field. 

23 Повторите шаги 20 и 21 для всех классов и кликните OK. 

24 Кликните Finish после того как все классы и атрибуты будут указаны. 
Далее проект будет создан автоматически.   

 
Созданный проект может использоваться в следующий раз в качестве 
шаблона. 
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2.1.2 Настройки изображения 

2.1.2.1 База гиперссылок 

 

EasyIn будет автоматически перемещать собранные изображения в 

ваш компьютер. 

Изображения сохраняются автоматически в местоположение 

Hyperlink base (база гиперссылок). 

Если база гиперссылок не задана, изображения хранятся по 

относительному пути к документу карты в Zeno Office. 

 

Если изображения должны сохраняться в отдельном месте, Вы 

можете указать его в настройках карты в Hyperlink base. 

Шаг Действие 

1 Кликните File > Document Properties… 

2 Введите необходимый путь в поле Hyperlink base, например c:\images. 
 

 
 

 
Убедитесь, что указанный путь  существует в вашей системе. Если 
указанной директории нет, изображения будут копироваться в ту же 
директорию что и сама карта.  

 

2.1.2.2 Настройка слоя ссылок 

Изображения по ссылкам могут быть показаны  в Zeno Office 

щелчком  по инструменту Hyperlink tool  на панели инструментов 

Tools. Поэтому гиперссылки должны быть указаны для каждого слоя 

который должен отображать изображения. 
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Шаг Действие 

1 Кликните правой клавшей слой в закладке Display в содержании и 
выберите Properties... 
 

 
 

2 Смените на закладку Display. 

3 Отметьте «Support Hyperlinks using field:». 
 

 
 

4 Выберите поле которое включает ссылку на изображение, например 
picture или image. 

5 Кликните OK. 

6 Повторите это для всех слоев которые содержат изображения. 

7 Сохраните карту. 

 
Это нужно указать один раз. Только используйте этот проект как шаблон 
карты в мастере проектов когда создаете новый проект в следующий 
раз.  
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2.1.3 Процесс EasyOut 

С помощью EasyOut Ваш проект Zeno Office можно легко передать  

в Zeno Field.   

Для экспорта существующей базы данных, которая не была создана 

через Project Wizard (мастер проектов), Вы должны создать Survey 

Dataset вручную (смотрите помощь Zeno Office). 

Шаг Действие 

1 Кликните кнопку «EasyOut to Zeno Field»    в панели инструментов 
Leica Data Manager. 

 
Если эта панель инструментов недоступна, выберите Customize в меню 
Tools и отметьте галочкой рядом с Leica Data Manager. 

2 Отметьте флажком Check Out те слои которые вы хотите передать.  
Отметьте флажком Copy Out те слои которые вам нужны для фонового 
использования. 

 
 

 
Для слоев «copy out» будет создан шейп файл который не может быть 
проверен позже используя EasyIn.  
Используйте Copy Out (только для чтения) для фоновых данных.  
Используйте Copy Out (редактируемый), если хотите изменять шейп 
файл в поле. 

 
Почему используется Copy Out?  
Карта рисуется фоновым слоем карты выполняя это немного быстрее.  
Сбор данных легче, т.к. фоновые слои используются только для чтения 
(по умолчанию). 

 
Отметьте флажком «check out only schema of data» если нужно только 
схеме (не данные) передать. 

3 Выберите текущее отображение для экспорта части карты.   

 
Вы также можете экспортировать только выбранные характеристики 
или зоны отмеченные графически.  

4 Введите имя проекта. 

5 Укажите расположение проекта. Вы можете напрямую указать 
мобильное соединение или папку обмена данными ActiveSync. 

6 Кликните OK и проект автоматически переместится в Zeno Field. 

 
Начиная с Zeno Field 3.0 и Zeno Office 3.0 все трансформации будут 
автоматиченски прикрепляться к устройствам Zeno через EasyOut. 
Больше нет необходимости в Datum Configuration Tool или другом. В 
дополнение, Geoid и модели CSCS будут поддерживаться прямо в Zeno 
Field.  
  
Начиная с Zeno Field 3.0 вы можете просматривать файл геоида в 
закладке координатной системы в настройках GNSS в Zeno Field (см. 
2.2.2.1 Create a new map шаг 6). Если EasyOut был сделан, Вы не можете 
редактировать файл геоида больше как это уже было определено в 
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проекте Zeno Office.  
  
Важное замечание: При использовании предыдущих версий Zeno 
Field/Zeno Office, трансформации должны применяться вручную в 
устройстве Zeno через Datum Configuration Tool (см. 2.2.3 Apply a 
transformation to your mobile device)  
 (только если не используется Zeno Office EasyOut или установлены Zeno 
Field <3.0 или Zeno Office <3.0).   

 Если ваш проект включает данные с разных геоданных или ваши классы 
имеют разные координатные системы это будет отображено 
сообщением. 
Пожалуйста, убедитесь, что все ваши данные имеют одинаковую 
пространственную привязку. EasyOut может быть сделан только из 
одной базы геоданных.   
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2.2 Создание проекта в Zeno Field 

Эта часть даст Вам вводную информацию как начать работать с готовым проектом и как с 

только что созданной.  

Leica Zeno Field это OEM версия ArcPad 10 и поставляется с 

дополнительной функциональностью ArcPad™: запись сырых данных 

GNSS, простое конфигурирование GNSS (такие как DGPS настройки), 

функция управления точностью и автоматизированным рабочим 

процессом между полем и офисом. Вместе с Zeno Office легко 

управлять качеством и использовать автоматические функции 

импорта и экспорта широкого диапазона различных форматов, таких 

как геоданные ArcGIS, шейпфайлы, dxf, dgn, и dwg. 

 

 Поправки в режиме реального времени   

 Запись сырых данных для постобработки для повышения 

точности  

 State-of-the-art полевые картографические инструменты 

 

Leica Zeno Field может использоваться для:  

 

 Полевой топографии  

 Поиск инвентарных единиц 

 Управление активами 

 Обследование 

 Отчетность об инцидентах 

 ГИС анализ и принятие решений) 
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2.2.1 Запуск с готовой картой 

 

Шаг Действие 

1 Запустите Zeno Field. Кликните «Choose map to open» (Выберите карту 
для открытия). Откроется диалог Open Map (Открыть карту). 

2 Откройте существующую карту.  
 

 
 
Карта для Zeno Field может быть создана в Zeno Office.  
Смотрите руководство «Create a project in Zeno Office» (Создание 
проекта в Zeno Office). 

 
В меню открытия карты Вы всегда найдете проекты сохраненные месте 
заданном по умолчанию. Для изменения этого пути пройдите в Zeno 
Field в Options (Опции) → Paths (Пути). 
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2.2.2 Начало с новой картой  

2.2.2.1 Создание новой карты 

Шаг Действие 

1 Запустите Zeno Field. 

2 Закройте диалог открытия карты или выберите новую карту. 

3 Первое что Вы выбираете это координатная система.   
В Zeno Field вам нужен файл .prj где внутри хранится информация о 
координатной системе.   
  
Такой файл может быть найден в директории установки Zeno Office на 
вашем компьютере в папке Coordinate Systems.  
  
Copy the desired .prj file to your Zeno device. 
 

4 Нажмите       для открытия Table of Contents (таблицы содержания).  
  
С правого края Вы найдете кнопку для указания координатной системы 

. Нажмите эту кнопку и выберите файл .prj который вы скопировали 
на ваше устройство Zeno. 
 

 
 

5 Выйдите из Table of Contents и сохраните карту.  

6 Опционально (с версии Zeno Field 3.0): Добавление файла геоида   
  

 Для достижения высокой точности ортометрической высоты 
все значения высот будут основаны на геоиде   

 Откройте GNSS Settings (Настройки GNSS)  
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 Переключитесь в закладку Coord. System  
 Отметьте флажком «Use Geoid File» (Использовать файл геоида) 

и укажите путь к вашему файлу геоида 
 

 
 

 Пожалуйста, запомните: Файл геоида может только быть добавлен если 
нет другого файла геоида уже прикрепленного в процессе EasyOut.  Там 
также нет поддержки геоида в Zeno 5 использующем внутренний Sirf-
GPS. 
 

7 Сейчас ваша карта готова для создания некоторых шейпфайлов. В 
шейпфалах Вы можете хранить точки, полигоны или  линии, плюс 
дополнительные атрибуты.   
Нажмите New (Новый) и затем Shapefile (Шейпфайл). 
 

 
 

8 Выберите между Point, Polyline и Polygon в списке «Type» (Тип). 
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9 Нажмите кнопку-плюс на странице для добавления некоторых полей 
атрибутов к шейпфайлу. 
 

 
 

10 Выберите имя для поля атрибута, выберите тип данных и укажите длину 
и точность. Подтвердите настройки кнопкой ОК. 
 

11 Повторите шаги 8 и 9 для указания других атрибутов. 

 
Для того, чтобы хранить фотографии в качестве атрибута в ваших 
данных, вы должны создать текстовое поле. В этом текстовом поле 
будет сохранена ссылка на изображение. 
Просто назовите текстовое поле "photo", "image" или "picture" и дайте 
ему минимальную длину 20 символов. 
Позднее это текстовое поле будет автоматически использоваться для 
хранения ссылки на картинку. 
 

12 Нажмите ОК. Выберите имя для шейпфайла и сохраните его. 
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13 После сохранения шейп-файла, Zeno Field спросит о создании 
QuickForm. 
 

 
 
Что такое QuickForm?  
  
Для того чтобы облегчить ввод данных в поле, вы можете создавать 
пользовательские формы ввода для любых шейп-файлов в ArcPad. 
QuickForms содержит основные функции и опции для создания форм в 
поле, где у вас нет доступа к вашему компьютеру. 
 

14 Нажмите Yes 

15 Сейчас вы можете редактировать QuickForm как нужно. 
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 
Например, указать, какие вкладки должны быть включены, определить 
минимальное и максимальное значения, создать предопределенные 
значения, которые будут отображаться в выпадающем списке 
(разделенные запятыми, не пустой). 

16 Повторите шаги 6-14 для создания других шейп-файлов. 
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2.2.2.2 Создание QuickProject 

 

Шаг Действие 

1 Запустите Zeno Field. 

2 Нажмите New –> Quick Project… 
 

 
 

3 Выберите Template (шаблон). Выбор шаблона создает QuickProject 
содержащего слои основанные на слоях шаблона. Zeno Field 
поставляется с 4 простыми шаблонами которые могут быть 
использованы и как шаблоны по умолчанию. 
 

 
 

4 Выберите Projection (Проекцию). 

 
Шаблон это обычный файл zip содержащий все слои составляющие 
шаблон, и файл .apm с названием Template.apm имеющий ссылки на 
все файлы слоя. Вы можете легко создать ваш собственный шаблон из 
нескольких слоев. Слои могут быть шейп-файлами, слоями AXF или 
растровыми слоями. 

 
Вы также можете прикрепить файл геоида. Для большей информации 
пожалуйста смотрите 2.2.2.1 Создание новой карты (шаг 6). 
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2.2.3 Применение трансформации в вашем мобильном устройстве (используется 

только если не был применен EasyOut в Zeno Office или установлены Zeno Field 

<3.0 или Zeno Office <3.0) 

 

Пожалуйста запомните: Эта глава требуется только когда используется Zeno Office <3.0 

для EasyOut или Zeno Field <3.0. Это также обязательно когда не был сделан EasyOut из 

Zeno Office.  

Datum Configuration Tool устанавливается вместе с Zeno Field на 

персональный компьютер и CS25. Вы можете:  

 Установить новую трасформацию между двумя датумами   

 Выбрать трансформацию по умолчанию  

 Файлы трансформации могут быть скопированы в Zeno  

Datum Configuration Tool редактирует два файла .dbf которые 

скопированы вручную на ваше мобильное устройство.    

Следующий процесс нужно сделать только один раз. Корректная 

трансформация будет использована автоматически для каждой карты 

которая использует сопутствующий датум. 

Datum Configuration Tool 

Шаг Действие 

1 Откройте «Datum Configuration Tool» в Start > All Programs > Leica 
Geosystems > Leica Zeno Field > Datum Configuration Tool 

 
Имеются две закладки в «Datum Configuration Tool». 
 

 
 

 В закладке «Define Datum Configuration» создание выбранной 
трансформации   

 Установка трансформации по умолчанию в закладке «Select 
Default Datum Configuration» 

2 Создание новой трансформации в закладке «Define Datum 
Transformation».   

 Введите имя для трансформации  
 Укажите Datum transformation Method  
 Выберите Datum 1 из списка (обычно WGS84)  
 Выберите целевой Datum 2 из списка  
 Отредактируйте параметры трансформации  
 Добавьте файл CSCS (только в Zeno Field > 2.1): наберите только 

имя CSCS файла в поле Dataset. Например, если ваш CSCS файл 
называется «Swiss.csc», введите «Swiss». 
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 
Для применения файлов NTv2 в the Datum Configuration Tool (только в 
Zeno Field > 2.1), сначала вам нужно конвертировать их в файлы CSCS.   
Поэтому пожалуйста пройдите Start → All Programs → Leica Geosystems 
→ Zeno Tools → CSCSModelConvert.  
В конвертере:  

 Выберите NTv2 как формат данных  
 Укажите путь для файла NTv2  
 Выберите путь для сгенерированного файла CSCS  

Соответственно в шаге 2, заполните в поле «Dataset» имя файла CSCS. 

3 Кликните Save (Сохранить) для сохранения этой трансформации. 

4 Переключитесь на закладку Select Default Transformation  

5 Выберите Datum и Associated Datum 
 

 
 

6 Список доступных трансформаций между обоих датумов отобразится.   

7 Check the checkbox in the Default Transformation column to set it as 
default.   
 

 
 

 
Трансформация по умолчанию будет использоваться автоматически для 
каждой карты которая использует соответствующие данные. 
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8 Кликните Save (Сохранить) для сохранения этой трансформации. 

9 В Manage Screen можно просмотреть выбранную трансформацию. 

10 Скопируйте файлы transform.dbf и defaulttransform.dbf с компьютера на 
мобильное устройство.  
Вы можете найти оба файла в следующем расположении:  

 Для установки Zeno Field 1.0:  
c:\Program Files\Leica Geosystems\Leica Zeno Field\System\  

 Для Zeno Field 1.1 onwards:  
c:\Documents and Settings\All Users\Documents\ArcPad\System\ 

11 Вставьте оба файла в   
 На Zeno 10/15 и Zeno 5: \Program Files\Zeno Field\System folder  
 На CS25: C:\Users\Public\Public Documents\Zeno Field\System 

12 Если вы также указали CSCS файл в Datum Configuration Tool (только 
Zeno Field > 2.1), убедитесь файл включен в вашу папку проекта (то же 
расположение что у файла .apm). Имя файла CSCS должно быть 
идентично имени указанному в Datum Configuration Tool. Он 
применится при запуске проекта в Zeno Field.   
  
Дополнительно файл будет скопирован в папку CSCS Models. 

13 Вы можете просмотреть используемые параметры трансформации в 
Zeno Field.   
Пожалуйста откройте Zeno Field. 

14 Откройте диалог GPS Preferences > закладка Datum. 

15 Нажмите на иконку Info (i). 
 

 
 

16 Отобразятся детали трансформации. 
 

 
 

 
В строке Dataset можно увидеть использованный CSCS. 
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3. Работа с Zeno Field  

3.1 Редактирование в Zeno Field  

3.1.1 Функциональные клавиши Zeno 10/15 

 

 
 Запуск измерения  

 + -  Переключение типа геометрии с Point в Polyline и в Polygon  

 1  Показать полностью   

 2  Увеличить  

 3  Уменьшить  

 5  Центрировать карту на позиции GPS (Auto-pan on/off)  

 0  Обновить карту 

      

ОК во всех диалогах   Перемещение влево/вправо 
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3.1.2 Функциональные клавиши Zeno 5 

 

 

 

a) Клавиши стрелок 
b) Клавиша разговора 
c) Клавиша сканирования 
d) Клавиша Windows 
e) Альфа клавиши / 

специальные символы 
f) SHIFT 
g) Esc / Ctrl 
h) Звездочка 
i) Цифровые клавиша 

j) Завершение вызова 
k) Клавиша включения 
l) функциональные клавиши 
m) ENTER  
n) Backspace / DELETE 
o) TAB / Alt 
p) BLUE / FN модификатор 
q) SYM 
r) Пробел

 

 

 c) и q): измерение  

 Стрелки:  

o влево & вправо: перемещение влево/вправо  

o стрелка вперед: уменьшить  

o стрелка назад: увеличить 
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3.1.3 Создание точечных объектов оцифровкой 

 

Шаг Действие 

1 Нажмите кнопку Start/Stop Editing  на панели инструментов. В 
раскрывающемся списке отобразятся все редактируемые слои текущей 
карты.  
 

 
 

2 Выберите точечный слой для редактирования. 
 

 
 

 
Вы можете выбрать один слой точек, один линии, и один слой 
полигональный для одновременного редактирования. 

3 Нажмите кнопку Point в панели инструментов Edit для начала отрисовки 
точки. 
 

 
 

4 Нажмите на карте. 

5 Введите атрибуты для новой точки. 
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3.1.4 Создание линии  

 

Шаг Действие 

1 Нажмите Start/Stop Editing и выберите слой линии для редактирования. 
 

 
 

2 Нажмите кнопку Polyline в панели инструментов Edit для начала 
обрисовки линии. 
 

 
 

3 Нажимайте на карте, создавая вершины. 
 

 
 

4 Нажмите Proceed для завершения обрисовки. 
 

 
 

5 Введите атрибуты для новой линии. 

6 Нажмите OK. 

 

 

3.1.5 Создание полигона оцифровкой 

 

Шаг Действие 

1 Нажмите Start/Stop Editing и выберите слой полигона для 
редактирования.  
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2 Нажмите кнопку Polygon в панели инструментов Edit для начала 
обрисовки полигона.  

 
 

3 Отметьте на карте вершины полигона.  

 
 

4 Нажмите Proceed для завершения обрисовки. 
 

 
 

5 Введите атрибуты для нового полигона. 

6 Нажмите OK. 

 

 

3.1.6 Создание объектов, используя панель инструментов QuickCapture 

 

Что такое QuickCapture?  

  

 С панелью инструментов QuickCapture (начиная с Zeno Field 

2.0), Вы можете одним щелчком создавать новые объекты на 

вашей карте.   

 QuickCapture это динамическая панель инструментов. Она 

содержит функции в зависимости от открытых слоев.  

Шаг Действие 

1 Откройте существующий проект или начните с QuickProject. 

2 Нажмите кнопку Quick Capture. 

 
3 По умолчанию, если слой определен в категорию символов (как в 
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QuickProject), первые три категории будут представлены на панели. 

 

4 После выбора одной характеристики вы готовы для редактирования.  

 
Для завершения полигона или линии нажмите Proceed на Command 
Toolbar. 

 
5 Введите атрибуты для нового объекта. 

 
Вы можете определить какие инструменты должны отображаться на 
панели QuickCapture отмечая категории в закладке QuickCapture в 
диалоговом окне Table of Contents. 
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3.2 Использование GNSS  

3.2.1 Настройки GPS (GPS Preferences) 

Редактирование GPS Preferences 

В Leica Zeno Field настройки GPS предварительно сконфигурированы. 

Подключение модуля Zeno GNSS автоматически гарантируется. 

Шаг Действие 

1 Откройте меню GPS и выберите GPS Preferences. 

 
 

2 Переключитесь на закладку Capture. 

 
 

3 Averaging (устреднение):   
 Возможно для нескольких наблюдений точечных объектов или 

вершин линий/полигонов.  
 По меньшей мере пять точек или вершин вполне достаточно 

для успешного измерения. 
Streaming (потоковая передача данных):  

 Используется для непрерывного рисования вершин линий или 
полигонов при использовании инструмента «Capture Vertices».   

 Position Interval: будет использоваться каждое X положение GPS.  
 Distance Interval: Рисуется позиция после перемещения на 

указанное расстояние.  

4 Нажмите OK. 

5 Перейдите на закладку «GPS Height». 
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Укажите высоту антенны над землей (Antenna Height). Например, 1 м 
при удерживании мобильного устройства в руке или 2 м при работе 
внешней антенной. 

6 Нажмите OK. 

 
В закладке Quality можно указать различные предупреждения на 
основе нескольких показателей качества GNSS. В случае превышения 
заданных значений, вы получите сообщение. 

 EPE (Estimated Position Error - оценка ошибки местоопределения) 
отражает текущую точность в строке состояния GNSS и является 
наиболее удобным показателем качества. 
Если регистрация сырых данных GNSS включена, EPE отражает 
предполагаемую точность постобработки. 

 

 

3.2.2 Подключение к GG03 / GG02 plus 

 

Шаг Действие 

1 Запустите Zeno Field. 

2 Откройте меню Zeno Field. Выберите GNSS Settings. 

 
 

3 Выберите GG03 или GG02 plus. 
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 
В зависимости от используемого устройства, могут быть выбраны 
различные антенны. 
Если выбраны GG03 или GG02 plus GNSS/GIS Smart Antenna, вы можете 
выбрать угол отсечки. 
В случае CS25 GNSS вы должны выбрать внешнюю антенну в 
дополнительных настройках. 

4 Включите Smart Antenna. Подключите к ней кабель (GEV 162) если Вы не 
хотите использовать Bluetooth (опционально для Zeno 10/15 и CS25). 

5 Нажмите активацию GPS 

 
6 Следующее окно покажет доступные антенны. Если ваша антенна 

подключена через кабель переключитесь в закладку Cable. 

 
 

7 Выберите вашу антенну для автоматического соединения и 
подключения. 

8 Отобразится сообщение об успешном подключении. 



 

Zeno GIS 
Быстрый старт 62  

 

 Подключение антенны настраивается один раз, в первый раз или при 
переключении антенны. В следующий раз настроенная антенна будет 
использоваться в качестве устройства по умолчанию при активации 
GNSS. 

 Для переключения с одной смарт-антенны на другую необходимо 
убедится, что предыдущая подключенная антенна выключена. 
Включите новую смарт-антенну и активируйте GNSS. Отобразится 
диалоговое окно поиска для выбора новой антенны. 

 

3.2.3 Настройка RTK  

3.2.3.1 Обзор 

Установки RTK  

Шаг Действие 

1 Для работы в реальном времени, спутниковые системы 
функционального дополнения (SBAS) уже заранее настроены и 
выбираются автоматически. Нет необходимости менять эти настройки. В 
следующей главе вы найдете описание как настроить свои собственные 
данные подключения RTK. 
 

 
Если вы хотите сделать пост-обработку данных позже в Leica Zeno Office, 
убедитесь, что активирована Raw Data Logging (эта опция не доступна 
при использовании Sirf GPS на Zeno 5).  
Откройте ниспадающее меню Zeno Field и выберите GNSS Settings. 

 
 

2 Переключитесь на закладку Raw Data и отметьте галочкой «Log data for 
post-processing».   
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3.2.3.2 Конфигурирование источника данных реального времени 

 
Имеются разные пути через которые пользователь может получать корректировки 

измерений реального времени:  

 Internet (интернет подключение) 

 Dial-up  (модемное соединение) 

 Beacon (радио) 

 

 Только SBAS is available when using the internal SIRF GPS on a Zeno 5. 

 

Internet Connections setup 

Шаг Действие 

1 
Нажмите кнопку . 

2 Нажмите ниспадающее меню и выберите Settings или нажмите кнопку 

. 

3 Нажмите кнопку создания нового профиля для запуска мастера New RTK 
Profile. 

 
 
При включении опции " Automatically connect to realtime source", Zeno 
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Field будет автоматически подключаться к выбранному источнику 
реального времени при активации GPS. 

4 Введите имя профиля и описание и сохраните установки подключения 
для использования позже. 

5 Выберите Internet как тип подключения и нажмите Next. 

 
 

6 Выберите интернет подключение, которое будет использоваться.  
 Выберите новое интернет подключение («Create new 

connection»). Это может быть внутренний модем или 
беспроводной модем, например Bluetooth мобильного 
телефона. Продолжить с шага 7.  

 Выберите использование существующего подключения («Use 
existing active connection»). Это может быть WIFI, LAN или другое 
существующее и интернет подключение. Продолжите с части 
RTK server 

 
 

7 Выберите между внутренним и внешним модемом (мобильным 
телефоном). Эта опция недоступна на Zeno 5. 
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 
При выборе внутреннего модема продолжите с 8a, при использовании 
внешнего модема продолжите с 8b. 

8a Введите PIN-код для SIM карты и нажмите Next.  Продолжите с пункта 
13. 

8b Убедитесь что ваш мобильный телефон включен, Bluetooth доступен и 
устройство готово для нахождения. 

9 Нажмите Search для поиска мобильного устройства. Все устройства с 
Bluetooth будут отображены в списке. 

10 Выберите ваше устройство и нажмите Next. 
 

 
 

11 Введите любой пароль, например 123 и нажмите кнопку Next. 
Подтвердите пароль в мобильном устройстве. 
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12 Сообщение должно отобразить успешное подключение. Нажмите Next. 

13 Выберите тип интернет подключения, которое вы хотите использовать. У 
вас есть выбор между GPRS/CDMA и модемное соединение dial-up CSD.  
См. ниже: Установка подключения GPRS / CDMA или интернет 
подключение через Dial-up (CSD). 

 

Установка подключения GPRS / CDMA 

Шаг Действие 

1 Выберите опцию интернет подключения GPRS/CDMA и нажмите Next. 
 

 
 

 
В зависимости от Вашего мобильного телефона, может понадобиться 
подтверждение подключения по телефону. 
Добавление Zeno 10/15 к известному списку устройств на вашем 
телефоне будет предупреждать об этом в большинстве случаев. 

2 Введите APN (Access Point Name) вашего интернет провайдера, 
например gprs.swisscom.ch. Нажмите Next. 
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3 Введите ваш ID пользователя и пароль для интернет подключения. 
Нажмите Next. 
 

 
4 Продолжите с части RTK server 

 

Интернет подключение через Dial-up (CSD) 

Шаг Действие 

1 Выберите «Using dial-up (CSD) Internet connection» и нажмите Next. 
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2 Укажите имя для сохранения информации о модемной станции для 
последующего использования. Введите телефонный номер интернет 
провайдера и тип протокола, используемого для подключения и 
нажмите Next. 
Параметры подключения могут быть получены от поставщика услуг RTK. 
Вы также можете редактировать и удалять существующие модемные 
подключения. 

3 Введите ID пользователя и пароль для вашего модемного подключения 
к интернет, и нажмите Next. 

 
 

4 Продолжите с части RTK server 

 

 

 

 

 

 

RTK server 

Шаг Действие 

1 Выберите существующий RTK Server в списке (если доступно) или 
создайте новый нажав кнопку New. 
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2 Введите параметры RTK сервера. Отметьте галочкой «User NTRIP with 
server» если хотите использовать NTRIP. Нажмите Next. 
 

 
 

 
Параметры сервера могут быть предоставлены вашим провайдером RTK 
услуги.  
Вы также можете редактировать или удалять существующие 
конфигурации RTK серверов. 

3 Выделите новый созданный сервер и нажмите Next. 
 

 
 

4 Либо выбрать точку монтирования из списка или ввести его вручную. В 
большинстве случаев, первый вариант будет более предпочтительной 
настройкой. Нажмите Next.  

 a. Выберите нужную точку монтирования из списка. Нажмите Next. 
 b. Вручную введите имя точки монтирования и нажмите Next. 

5 Выберите формат данных RTK (Data Format)  для сервера RTK на основе 
требуемой конфигурации от поставщика RTK услуги. Нажмите Next.  
  
Выберите тип антенны для базовой антенны. Эта информация может 
быть предоставлена поставщиком сетевой поправки. 
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 
Большинство сетевых поправок или базовых станций настроены для 
устранения смещения антенны. В этой части может быть выбрано 
ADVNULLANTENNA. 

6 Диалоговое окно состояния соединения появится и проверит все 
необходимые части конфигурации. 
Нажмите Finish после успешного испытания соединения. 
Нажмите Back, чтобы исправить ошибки в конфигурации. 
 

 
 

 
Совет: Для повышения точности позиционирования рекомендуется 
использовать Smart Antenna GG03 или GG02 plus 
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3.3 Сбор данных с GNSS 

3.3.1 Подготовка для работы с GNSS 

 

Работа с GNSS 

Шаг Действие 

1 Откройте ниспадающее меню GPS. 
 

 
 

2 Нажмите GPS Active. Вы автоматически подключитесь к антенне которую 
в настройках GNSS. 

3 Начнется отслеживание спутников. Во время этого процесса в нижней 
части будет красное окно. 
 

 
 

4 Если данные GPS позиции доступны, красное окно загорается зеленым и 
показывает некоторую информацию о местоположении. Также появится 
курсор GPS на карте. 
 

 
 

 
Если вы выбрали в настройках запись данных для пост-обработки GNSS, 
вы сможете найти символ в строке состояния GNSS, который показывает 
вам оценку точности пост-обработки. 
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3.3.2 Запись точек используя GNSS 

 

Измерение точек 

  

Шаг Действие 

1 Нажмите Start/Stop Editing и выберите слой точек для редактирования. 
 

 
 

2 Нажмите кнопку Point для запуска отрисовки точки. 
 

 
 

3  

Нажмите    для записи измеренной через GNSS точки. 
 

4 Введите атрибуты для новой точки. На верхнем краю диалогового окна 
вы можете найти прогресс (в процентах) GNSS измерения. 
 

 
 

5 Нажмите OK. Точка будет сохранена в слое. 
 

 Вы также можете использовать панель инструментов QuickCapture для 
сбора точек GNSS. 
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3.3.3 Запись линий используя GNSS 

 

Измерение линии 

Шаг Действие 

1 Нажмите Start/Stop Editing и выберите слой линий для редактирования.  
 

 
 

2 Нажмите кнопку Polyline для начала отрисовки линий.  
 

 
 

3  

Нажмите     для записи измеренных через  GNSS вершин. Добавьте 
несколько вершин для построения линии.   
 

4 Нажмите Proceed для завершения отрисовки. 
 

 
 

5 Введите атрибуты для новой линии. 
 

6 Нажмите OK. 
 

 Вы также можете использовать панель инструментов QuickCapture для 
записи линий через GNSS. 
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3.3.4 Запись полигональных данных используя GNSS 

 

Измерение полигона 

Шаг Действие 

1 Нажмите Start/Stop Editing и выберите слой полигонов для 
редактирования. 
 

 
 

2 Нажмите кнопку Polygon для начала отрисовки полигона. 
 

 
 

3  

Нажмите    для записи измеренных через GNSS вершины. Добавьте 
несколько вершин для построения полигона.   
 

4 Нажмите Proceed для завершения отрисовки. 
 

 
 

5 Введите атрибуты для нового полигона.  

6 Нажмите OK. 

 Вы также можете использовать панель инструментов QuickCapture для 
сбора полигонов через GNSS. 
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3.4 Поддержка слоев ArcGIS Online 

 

Zeno Field (с версии 2.0) позволяет интегрировать слои ArcGIS Online.   

Эти слои могут быть использованы как фоновая информация в 

проекте Zeno Field: 

 Bing Maps Roads 

 Bing Maps Aerial  

 Bing Maps Hybrid  

 World Physical Map  

 World Street Map  

 World Topo Map 

 

Шаг Действие 

1 Для добавления базовой карты ArcGIS Online к новой карте, выберите 
Add Data from Server. 
 

 
 

2 Выберите один из доступных сервисов ArcGIS Online. Например, ArcGIS 
World Street Map. 
 

3 После сохранения слоя ArcGIS Online, он будет отображаться в Zeno 
Field. 
 

 
Однажды подключившись через интернет, Zeno Field кэширует онлайн 
службы ArcGIS для частичного покрытия площади. Это кэшированная 
база слоев может быть использована в полевых условиях без интернета 
в течении 24 часов.  
 

 
При использовании базовых карт ArcGIS Online с существующими 
данными, убедитесь что добавили существующие данные на карту 
ArcPad в первую очередь. Затем ArcPad повторно пересоздает проект 
базовых карт ArcGIS Online на лету, в соответствии с существующей 
проекцией данных. 
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3.5 Работа с камерой   

 

3.5.1 Обзор 

 

Zeno Field полностью поддерживает внутреннюю камеру мобильного 

устройства. Имеется два пути использования изображений в Zeno 

Field:  

 

 Как отдельные изображения: эти изображения не являются 

частью атрибутов слоя GIS.   

 Как часть атрибутов: изображения будут сохранены как 

дополнительная информация данных. Например, у вас есть 

слой с тремя разными видами деревьев. Вы можете добавить 

фото для каждого дерева, которое будет переработано как 

атрибут.  

  

 Очень важно: Для использования внутренней камеры на Zeno 10/15,  

рекомендуется использовать программу WinCE 3.5 или выше!  
  

Что должно быть упомянуто для сохранения фотографий? 

  

 Отдельные изображения: нет необходимости в каких-либо 

подготовках.   

 Как часть атрибута: Для хранения фотографии как атрибута 

ваших данных, вы должны создать текстовое поле как атрибут 

в классе данных (точки, линии, полигоны). В этом текстовом 

поле будет сохранена ссылка на изображение. Просто 

назовите текстовое поле «photo», «image» или «picture» и 

задайте ему минимальную длину 20 символов. Вы можете 

создать такое текстовое поле либо в Project Wizard в Zeno 

Office или прямо в Zeno Field при создании нового шейп-

файла. 

 

  



 

Zeno GIS 
Быстрый старт 77  

3.5.2 Настройки камеры 

 

Шаг Действие 

1 Откройте диалог Options. 

 
 

2 Переключитесь на закладку Camera. 

3 Выберите вашу камеру в ниспадающем меню Camera.  
Внутренняя камера установлена по умолчанию. 
 

 
 

4 Установите путь для изображений по умолчанию (Default Picture Path) 
где они будут храниться (опционально).   

5 Выберите префикс (Filename Prefix) имени файла (опционально). 

 Есть разница между изображениями, которые сохранены как 
атрибутивная информация и фотографиями, которые принимаются как 
"отдельные". Путь к изображению и префикс имени файла влияет 
только на фотографии, которые не сохранены как атрибутивная 
информация. 
  
Изображения, которые являются частью атрибута, всегда хранятся в 
папке проекта и имеют имя атрибута поля в качестве префикса имени 
файла. Например, слой называется "street", и фотография хранится в 
поле атрибута "picture", то полное имя фотографии будет к примеру 
"picture_00002.jpg" 

6 Сдвиньте ползунок «Picture Quality» для изменения качества снимков. 
Качество и размер фотографии увеличивается слева направо (по 
желанию). 

7 Отметьте галочкой «Date/time in filename» для отображения даты и 
времени в имени файла (опционально). 

 

 

3.5.3 Создание отдельного фото 

 

Шаг Действие 

1 Нажмите на маленькую черную стрелку под значком «Options». 

 
 



 

Zeno GIS 
Быстрый старт 78  

2 Нажмите кнопку «Camera». 

 
 

3 Нажмите «Capture» для создания фото. 

 
 

4 Для сохранения изображения, нажмите «Save». Иначе нажмите 
«Discard» для создания нового фото.   

 
 

5 После сохранения изображения Вы получите сообщение которое укажет 
путь к файлу. 

 
 

6 Нажмите OK. 

 Текущие GPS координаты автоматически добавятся к EXIF заголовку 
(метаданные файла) полученного jpg файла. 
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3.5.4 Использование фото в качестве атрибута 

Изображения как атрибуты 

Шаг Действие 

1 Создайте точку, линию или полигон. 

2 В таблице атрибута данных переключитесь на закладку «Picture». 

 
 

3 Нажмите на список «Field» для выбора поля в которое путь к фото будет 
сохранен. Zeno Field автоматически выбирает поля с именами «photo», 
«image» или «picture». 

4 
Нажмите кнопку камеры   внизу страницы. 

5 Нажмите «Capture» для создания фото. 

 
 

6 Для сохранения изображения нажмите «Save». Иначе нажмите 
«Discard» для создания другого фото.   
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7 Вы можете повернуть изображение с помощью кнопок Rotate left/Rotate 
right.  

 
 

8 Нажмите OK для сохранения изображения как атрибута. 

 Вы также можете просмотреть изображение как атрибут на диске. 

 
 

 Текущие GPS координаты автоматически добавятся к EXIF заголовку 
(метаданные файла) полученного jpg файла. 
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3.6 Работа с дальномером 

 

Дальномер может использоваться для измерения:  

 

 Расстояние, азимут, угол наклона  

 Одной фиксированной позиции  

 Двух фиксированных позиций  

  

Поддерживаются следующие протоколы:  

 Протокол обмена Leica DISTO  

 Формат передачи данных Leica Vector/Laser Locator  

 Laser Atlanta $LA1KA (оригинальный), $LA1KD (расширенный), 

$LA1KC (CMT, Corvallis MicroTechnology)   

 LaserCraft Contour $PLCI  

 Формат Laser Technology Criterion 400 ($PLTIT)  

 Measurement Devices Ltd. $PMDLA 

 

3.6.1 Подключение дальномера к вашему устройству  

3.6.1.1 Подключение дальномера к Zeno 10/15 

 

Шаг Действие 

1 Запустите Bluetooth на вашем Zeno 10/15 кликнув  
Start > Programs > Zeno Tools > Bluetooth Manager 

2 Включите ваш дальномер 

3 
Нажмите «Search»  (Поиск) для поиска Bluetooth устройств в вашем 
диапазоне. Через некоторое время должны найтись новые устройства. 

 
 

 
Совет: Пожалуйста, убедитесь что Bluetooth на устройствах включен и 
готов для поиска. 

4 Нажмите на дальномер, который должен использоваться и кликните 
«Open» в контекстном меню. Будут показаны службы устройства. 
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5 Нажмите на «Pair» для соединения для совместного использования. 

 
Совет: Пожалуйста, обратитесь к руководству пользователя устройства 
Bluetooth, если не знаете требуется ли соединение в пару или нет, т.к.  
зависит от устройства. Там вы должны найти ключ (пароль) для 
использования. 

6 Нажмите на службу последовательного порта и кликните «Connect» в 
контекстном меню. 

 
 

7 Выберите COM порт для подключения к устройству. В этой части: COM4 

 
 

8 Нажмите OK. 

9 Сейчас устройство дальномера и Zeno соединены. Если вы кликните на 

«Registered devices»  , вы сможете увидеть все подключения к 
устройствам включая детали COM порта. 

 
 

10 Далее вы можете закрыть   Bluetooth Manager и перейти в Zeno Field. 
Перейдите к пункту 3.6.2 Использование дальномера в Zeno Field 
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3.6.1.2 Подключение дальномера к CS25 

 

Шаг Действие 

1 Включите дальномер. 

2 Откройте меню Bluetooth Devices кликнув иконку Bluetooth в панели 

задач . Выберите «Add a device». 

3 Подождите пока дальномер отобразится. 

 
 

4 Выделите дальномер и выберите «Enter the device’s pairing code».   
  
Введите код дальномера для подключения и нажмите OK. Вы можете 
найти в инструкции к устройству. Устройство будет подключено.  

5 Снова кликните иконку Bluetooth в панели задач . 

6 Откройте контекстное меню подключенного дальномера и выберите 
«Properties». 

 
7 Переключитесь на закладку Services. Здесь вы можете найти 

последовательный порт Bluetooth через который подключены. 
Пожалуйста запомните этот порт. 
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8 Дальномер сейчас подключен к вашему CS25. Пожалуйста продолжите с 
пункта 3.6.2 Использование дальномера в Zeno Field 

 

 

3.6.1.3 Подключение дальномера к Zeno 5 

 

Шаг Действие 

1 Включите дальномер. 

2 Откройте Wireless Manager в Settings  Connections  

 Wireless Manager  . Включите Bluetooth. 

3 Откройте меню Bluetooth в Settings  Connections  Bluetooth  .   

4 Переключитесь в закладку «Device». Нажмите кнопку «Scan» снизу окна 
для поиска всех Bluetooth устройств в вашем диапазоне. 

 
 

5 Выберите ваш дальномер и нажмите «Pair».   

6 Введите код дальномера и нажмите OK. Код вы можете найти в 
инструкции к дальномеру. Это устройство будет подключено. 
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7 Отметьте галочкой «Serial Port» для использования последовательного 
порта.   

 
 

8 Выберите COM порт дальномера к которому должны быть подключены. 
Нажмите OK. 

 
 

9 Дальномер сейчас подключен к вашему Zeno 5. Пожалуйста продолжите 
с пункта 3.6.2 Использование дальномера в Zeno Field 

 

 

 

3.6.2 Использование дальномера в Zeno Field 

 

В этой главе рассказывается, как сделать измерение смещения с 

азимутом и расстоянием. Поэтому ваш дальномер должен иметь 

встроенный компас. 
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Шаг Действие 

1 Запустите Zeno Field. 

2 Откройте «Rangefinder Preferences» в основной панели инструментов.  

 
3 Укажите протокол в соответствии с вашим устройством. 

4 Укажите порт к которому подключен дальномер.  

 
 

5 Укажите скорость передачи данных («Baud») если необходимо. 

6 Отметьте «Automatically Activate» (автоматическое активирование). 

7 Нажмите OK. 

8 Нажмите Rangefinder Active (Активировать дальномер).   

 
 

9 Выберите редактирование точек. 
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10 Нажмите кнопку Offset Point (Смещение точки). 

 
11 Измерьте местоположение и расстояние дальномером. Появится 

диалоговое окно Point/Vertex. 

12 Переключитесь на закладку Offset (Смещение) и проверьте измеренные 
значения. 

 
 

13 Нажмите кнопку базовой точки.  

14 Нажмите символ спутника для измерения точки через GPS. 
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15 Нажмите OK дважды. 

16 Введите если необходимо атрибуты и нажмите ОК. 
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3.7 Работа с кабелеискателем Digicat 
 

В этой главе пошагово рассказывается как сохранить значение 

глубины измеренное с помощью кабелеискателя Digicat (или Ezicat в 

Zeno Field. 

Обратите внимание, что Digicat с Bluetooth соединением и 

возможностью указания глубины является обязательным. 

 

В настоящее время связь может быть установлена только между 

Digicat и Zeno 5/10/15.  
 

Шаг Действие 

1 Подключите ваш Zeno 5/10/15 с помощью кабеля к вашему компьютеру. 

2 Загрузите и установите программное обеспечение Digicat PPC на ваш 
компьютер. Вы можете найти его на портале myWorld.  
Следуйте инструкциям, чтобы установить программное обеспечение 
Digicat PPC на вашем мобильном устройстве. 

3 Запустите инструмент Digicat transfer через Start  Programs  Digicat 
transfer 

4 Откроется окно Digicat transfer. И пока Digicat не обнаружен.  

 
 

5 Нажмите и удерживайте пусковой механизм на Digicat, чтобы 
активировать Locator. Убедитесь, что соединение Bluetooth включено на 
устройстве. Пожалуйста, прочтите инструкцию к вашему Digicat для 
получения дополнительной информации. 

6 Инструмент Digicat transfer обнаружит устройство Digicat автоматически. 
Не необходимости в соединениях перед этим. 

 
 

В окне Digicat transfer вы найдете информацию о использующемся 
устройстве, а также зеленый индикатор. Он указывает на сигнал Locator 
(Эта информация совпадает с индикатором мощности сигнала на 
Digicat). 

 
Теперь пришло время для измерения значений глубины. Следующие 
несколько шагов показывают как настроить Digicat устройства, это также 
можно найти в руководстве пользователя Digicat. Пожалуйста, обратите 
внимание, что для измерения глубин требуется внешний зонд. 

7 Включите зонд и установите его на нужную частоту. Обратитесь к «7. 
How to Use the Sonde» в руководство пользователя Digicat для 
получения дополнительной информации. 

8 Выберите режим 33 kHz или 8 kHz в соответствии с выходным сигналом 
зонда.  
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Установите локатор прямо над зондом. Обратитесь к «7. How to Use the 
Sonde» в руководство пользователя Digicat для получения 
дополнительной информации. 

9 Нажмите и удерживайте кнопку «i» на локаторе в течение 2 секунд, пока 
пунктирные линии не прокрутятся один раз. 

10 На дисплее будет отображаться глубина зонда и его режим. 

 Здесь графически изображен рабочий процесс с Digicat. 

 
11 Когда чтение значения глубины будет произведено, на локаторе 

отобразится LOG. Для передачи данных в регистратор данных нажмите 
кнопку «i», пока будет отображаться LOG. Убедитесь, что курсор 
находится внутри окна Digicat transfer. 

12 Значение глубины будет отображено в окне передаче данных. 

 
 

13 Сейчас мы сохраним значение глубины в Zeno Field. Поэтому откройте 
проекта в Zeno Field. 

14 Создать деталь рельефа (точка, линия, полигон), вручную или 
измерением, до открытия диалога атрибута. 

15 Кликните в соответствующее поле и измерьте глубину в соответствии с 
шагом 7-11. 
Значения будут переданы в поле атрибута в Zeno Field. 
   

 
 

16 Сохраните это. 

 
Инструмент Digicat transfer передает измеренное значение всегда туда 
где находится курсор. Это работает в различных программ, такие как 
Excel, Notepad ... 
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4. Передача ваших данных обратно в Zeno Office с помощью 

EasyIn  

4.1 Предпосылки 
 

Введение 

 

EasyIn – передача данных из Zeno Field в Zeno Office  

 

 Передача данных из мобильных устройств  

 Автоматизация рабочего процесса в один-клик  

 Интегрирование данных из многих источников  

 Включена дополнительная пост обработка 

 

Предпосылки 

Внимание: для успешной передачи ваших полевых данных в Zeno 

Office, вы должны учитывать четыре условия: 
 

1 Работа в EasyIn возможна только с переданными данными в Zeno Field 
через EasyOut с использованием Check Out. 

2 Работа EasyOut и EasyIn должна быть из одного и того же проекта. 

3 Должна быть включена панель инструментов Survey Editor. Поэтому 
перейдите в Tools  Customize и поставьте флажок рядом с Editor. 

4 Start Editing должно быть активным. 

 

 

4.2 EasyIn 
Работа с EasyIn 

Шаг Действие 

1 Запустите Zeno Office. 

2 Откройте проект с которым вы хотите объединить данные в  Zeno Office. 

3 Кликните Editor  Start Editing. 
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4 Нажмите на кнопку EasyIn    на панели инструментов Leica Data 
Manager. Если эта кнопка не доступна, пройдите  Tools  Customize и 
выберите панель инструментов Leica Data Manager. 

5 Если вы получите сообщение с ошибкой, 
 

 
 
перейдите в Tools  Customize и выберите панель инструментов Leica 
Survey Editor. 

6 Укажите местоположение проекта (Location). Вы можете напрямую 
указывать через мобильную связь или папку обмена данными 
ActiveSync. 
 

 
 

7 Выберите все необходимые классы. 

8 Отметьте флажком  Import Observations (импорт наблюдений) , если вы 
хотите сделать пост-обработку сейчас или позже. 

9 Отметьте  Post Process Observations (пост-обработка наблюдений), если 
вы хотите, чтобы EasyIn произвел пост-обработку ваших сырых данных. 

10 Укажите местоположение ваших опорных данных: 
 Local: Выберите «Browse for Reference Data» для указания 

расположения опорных данных или «Auto select Reference 
Data» для выбора директории содержащей данные. Поэтому вы 
должны указать путь к данным в настройках. 

 
При выборе «Auto select Reference Data»: всегда копируйте ваши 
базовые станции в ту же самую папку. EasyIn автоматически берет 
необходимые фалы опорных данных из этой папки. 



 

Zeno GIS 
Быстрый старт 94  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  IGS Network: для автоматической загрузки опорных данных. 

11 Нажмите OK. 

12 Появится EasyIn Live Data Viewer и сообщит обо всех шагах 
выполняющихся автоматически через EasyIn. Этими процессами 
являются:  

1. Резервное копирование полевого проекта, повторяется  EasyIn  
позже если требуется.  

2. Импорт фото привязанных к данным собранным в Zeno Field.  
3. Проверка деталей рельефа (точки, линии, полигоны).  
4. Измерение создания точки для каждой точки/вершины. 

Момент измерения включает например качество информации 
для каждой точки/вершины. 

5. Импорт измерений смещения.  
6. Импорт ровер данных.  
7. Импорт данных базовых станций.  
8. Пост-обработка с детальным отчетом.  
9. Обновление точек, линий, полигонов, для последующей 

обработки позиций и повторного вычисления смещения точек. 
10. Синхронизация проекта между офисом и полевыми 

измерениями, для исключения двойного ввода. 
 

 
 

 
Процессы выполняются в зависимости от проекта и содержащихся 
данных. 
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5. Работа с Zeno Office  

5.1 Открытие карты 
 

Открытие документа карты 

Имеется несколько путей для открытия карты в Zeno Office.  

   

Вы можете:  

 Дважды кликнуть на файле карты (*.mxd) для ее открытия.   

 Выбрать карту в диалоговом окне Getting Started при запуске 

Zeno Office.   

 Кликнуть кнопку Open на стандартной панели инструментов.   

  

Открытие карты двойным щелчком 

 

 

 

 

 

 

Выбор карты в диалоговом окне Getting Started при запуске Zeno Office 

 

 

 

 

 

 

 

Открытие другой карты при работе в Zeno Office  

  

Если вы уже работаете в Zeno Office, вы можете выбрать для 

открытия другую карту. Это позволит закрыть уже открытую карту и 

открыть новую на её место. 

 

 

 

 

 

5.2 Добавление набора данных 

 

Имеется несколько путей для добавления набора данных. Набором 

данных могут быть:  

 Класс данных (точки, линии, полигоны)  

 Шейп-файл  

 CAD файл (dxf, dgn, dwg)  

Шаг Действие 

1 В Windows Explorer (проводник), перейдите в папку расположения 
карты.  

2 Дважды кликните файл для открытия карты. 

Шаг Действие 

1 При запуске Zeno Office из меню Windows Start вы увидите диалоговое 
окно Zeno Office Getting Started.   

2 Выберите существующую карту или укажите путь к ней для открытия в 
Zeno Office. 

Шаг Действие 

1 Кликните кнопку Open (Открыть)  на стандартной панели 
инструментов (или нажмите File  Open).   
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Использование кнопки Add Data 

Шаг Действие 

1 Нажмите кнопку Add Data   

2 Перейдите к нужному набору данных. Затем выберите и добавьте его в 
вашу карту.  
 

 
 

 

Копирование или перетаскивание слоя 

 

 

 

 

 

 

5.3 Перемещение по карте 

Панель инструментов Tools является одним из основных способов, 

которыми вы взаимодействуете с географической информации, 

отображаемой во фрейме данных. Панель содержит инструменты 

для работы с содержимым в активном фрейме данных, например, 

для перемещения и масштабирования вашей карты, для 

определения класса данных и измерения расстояний. 

 

 
 

Описание самых важных инструментов 
 

Символ Имя Назначение 

 
Zoom In 

Позволяет увеличить масштаб, нажав на точку 
или переместив курсор. 

 
Zoom out 

Позволяет уменьшить масштаб, нажав на точку 
или переместив курсор. 

 Действие 

 
Вы можете перемещать слои между фреймами данных или карты путем 
копирования и вставки, или перетаскивания слоя из одного фрейма в 
другой. 
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Pan Позволяет вам перемещать фрейм данных, карту.  

 
Full extent 

Позволяет масштабировать карту до полного 
размера в окне.  

 
Fixed zoom in Увеличивает к центру вашей карты. 

 
Fixed zoom out Уменьшает масштаб из центра вашей карты. 

 
Back Вернуться назад. 

 
Forward Вперед. 

 
Select features 

Выбор деталей карты, кликнув или растянуть 
рамку вокруг них. 

 
Clear selection 

Снимает выбор со всех выбранных компонентов в 
активном фрейме данных. 

 
Select elements 

Позволяет вам выбрать, изменить размер, и 
передвинуть текст, графику, и и другие 
расположенные на карте объекты.  

 
Identify 

Идентифицирует географический объект или 
место, на котором вы щелкнули. 

 
Hyperlink Инициирует гиперссылки из деталей карты. 

 

 

5.4 Использование Table of Content (Таблицы содержания) 
 

В таблице содержания перечислены все слои на карте и показано 

какие детали карты (точки, линии, полигоны) представлены в каждом 

слое.   

  

Таблица содержания в основном используется для того чтобы 

включить и выключить слои, доступа к свойствам слоя, и изменение 

слоев при изменении порядка отрисовки (порядка слоев). Вы можете 

отобразить Table of Contents с закладками «List by Drawing Order», 

«List by Source», «List by Visibility», «List by Selection». 
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Вы можете открыть контекстное меню класса данных щелкнув 

правой кнопкой мыши на них. В этом контекстном меню вы можете 

сделать к примеру следующее:  

 Открыть таблицу атрибутов (для обзора информации 

атрибутов)  

 Экспорт класса данных (точки, линии, полигоны)в другие 

форматы  

 Проверка и редактирование свойств класса данных  

 … 

 

5.5 Свойства фрейма данных 
 

Каждый фрейм данных это географическое окно для отображения 

информации ГИС. Фреймы данных имеют свойства определяющие 

контекст, для отображения и работы с данными, которые они 

содержат. Для просмотра и установки свойств фрейма данных: 
 

Шаг Действие 

1 Щелкните правой клавишей по имени фрейма данных в таблице 
содержания (см. главу 5.4 Использование Table of Content). 
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2 Кликните Properties (Свойства). 

3 Вы можете установить и сделать предпросмотр различных свойств в 
каждой закладке в этом диалоговом окне. 
 

 
 
Система координат является одним из наиболее важных свойств, 
потому что она определяет картографическую проекцию для фрейма 
данных. Как правило, система координат вашего фрейма данных 
определяется системой координат первого набора который вы 
добавляете к вашей карте. Вы можете просмотреть и установить систему 
координат из вкладки  Coordinate System в диалоговом окне  Data Frame 
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Properties . 

 

5.6 Zeno Office Toolbox   
 

Окно ArcToolbox является центральным местом, где можно управлять 

и работать с различными инструменты геообработки. 

  

Окно ArcToolbox содержит инструментарии, которые содержат 

инструменты и наборы инструментов (набор инструментов находится 

только в штатном устройстве, как и системные папки). Инструменты 

содержаться только в панели инструментов, их не найти вне панели 

инструментов. 
 

Шаг Действие 

1 Вы можете открыть панель инструментов кликнув Geoprocessing Arc 
Toolbox 
 

 
 

2 Панель инструментов будет отображаться как отдельное окно. Вы 
найдете множество различных инструментов, которые могут помочь 
вам, например, для импорта / экспорта данных, конвертировании 
классов или управления данными. 

3 Существуют различные способы, чтобы найти подходящий инструмент. 
 По умолчанию вы можете перейти прямо к инструменту 

непосредственно в ArcToolbox 
 Поиск по названию инструмента в окне поиска (Windows  

Search). 
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5.7 Геодезические данные  

5.7.1 Общий обзор 
 

Zeno Office / Zeno Office на ArcGIS хранит два различных набора 

данных в базе данных: 

 
 

Геодезические точки хранятся в наборах данных и привязываются к 

пространственным объектам. Здесь есть прямая связь между 

пространственным объектом и геодезической точкой.  

Вот так выглядит концепция привязки: 
 

 

 

Измерения     Объект  Привязанный объект 

 
 

EasyIn привязки объектов измеренные вами, автоматически 

привязываются измеренными точками.  

 

 

 
 

 

 

 

Геоданные 

Класс пространственных объектов 

Коллекция из объектов одного типа и 

пространственной привязки. Он хранит геометрию и 

атрибуты. Основные типы класса пространственных 

объектов являются точка, линия и полигон. 

Набор данных и проект съемки 

Набор данных содержит один или несколько 

проектов съемки с одной пространственной 

привязкой. Внутри проектов съемки хранятся 

геодезические данные (геодезические точки, 

координаты, измерения, расчеты). Геодезические 

точки могут ссылаться на класс известных 

геодезических объектов. 
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Здесь очень много геодезической информации, которая может быть 

пересмотрена и отредактирована внутри проекта Zeno Office. 

В зависимости от специфики проекта может быть запрошена 

следующая информация:  

 Данные о точках съемки, как например, координаты и 

качество информации. 

 Наблюдения GNSS с значениями качества, высотой антенны, 

использованных спутников, и т.д.  

 Пост обработка GNSS: тип решения, качество  

  … 
 

5.7.2 Запрос геодезической информации в Survey Explorer  

5.7.2.1 Принцип 

Survey Explorer 

Вы можете просматривать и редактировать геодезические объекты в 

Survey Explorer. Survey Explorer представляет собой контейнер для 

страниц геодезической информации. Вы можете создать эти 

страницы при работе. 

  

Имеется две разных возможности как отобразить геодезическую 

информацию:   

 Списком геодезических объектов через запрос (List Survey 

objects by Query), который отображает детали отдельных 

пространственных объектов  

 Инструмент списка геодезических объектов (List Survey 

Objects), который отображает список нескольких 

геодезических объектов по запросу 

5.7.2.2 Инструмент List Survey objects 
 

Этот инструмент позволяет выбрать геодезическую информацию 

прямо из карты. 

Шаг Действие 

1 Убедитесь что панель инструментов Leica Survey Editor активирована. 
Иначе откройте диалог Customize (Tools → Customize) и отметьте на 
закладке Toolbars пункт Leica Survey Editor.  

2 Кликните кнопку List Survey Objects Tool в панели инструментов Survey 
Editor. 
 

 
3 Нажмите и выделите рамкой вокруг точки съемки и измерений которые 

Вы хотите вывести списком. 

4 Откроется Survey Explorer, и на новую страницу будет добавлен список 
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измерений и точек запрошенных вами на карте.  

 
 

Для большей информации смотрите главу 5.7.2.4 Navigate to survey 
point details in the Survey Explorer 

 
Геодезические данные могут быть запрошены когда Survey Data Set is 
applied and Survey Data is inside of the project. 

 

5.7.2.3 List Survey objects by Query 
Дает вам список геодезических объектов в Survey Explorer через указанный запрос. 

Шаг Действие 

1 Убедитесь что панель инструментов Leica Survey Editor активирована. 
Иначе откройте диалог Customize (Tools → Customize) и отметьте на 
закладке Toolbars пункт Leica Survey Editor.  

2 Кликните кнопку List Survey Objects Tool на панели инструментов Survey 
Editor. 
 

 
 

3 Появится диалоговое окно List Survey Objects by Query.  
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4 Отметьте типы объектов для запроса. 

5 Если вы хотите выполнить запрос, нажмите кнопку «Query Builder…» 
(необязательно). 

6 Создайте запрос согласно вашим потребностям.  

 
 

7 Кликните OK дважды.   

8 Отобразится информация по вашему запросу.   
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5.7.2.4 Переход к деталям точек съемки в Survey Explorer 

 

В этой главе рассказывается, как перейти к подробной странице с измеренными 

точками внутри Survey Explorer. Не имеет значения, как вы ввели геодезическую 

информацию (в соответствии с 5.7.2.2 Инструмент List Survey objects или 5.7.2.3 List 

Survey objects by Query). 

 

Шаг Действие 

1 Убедитесь что созданный вами список с тьочками съемки с выделения 
или с запроса.  

 
 

2 Для отображения детального просмотра отдельных точек, Вы должны 
выбрать линию точки съемки, нажав на ведущей. 

3 Кликните правой клавишей по выделенной линии.  

4 Выберите «Go to Details».   

 
 

 
Для ввода GNSS измерений точек съемки, выберите « Go to 
Measurement» 

 Для удаления точек съемки, выберите необходимую линию и нажмите 

красный крест   . 

 Для создания текстового отчета на основе выделенных данных, 
выделите необходимые линии и выберите «Survey Object Report…» 

 Перейдите к следующей  или предыдущей странице   с 
помощью стрелок. 

5 Отобразится страница сведений для выбранных точек.  
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 Закладка General: имя точки съемки (может быть изменен) и 
ГИС координаты (координаты где измеренная точка находится 
на карте). 

 Закладка Quality: Стандартное отклонение (Standard Deviation) 

и другие параметры качества.  
 Coordinate Manager: Сохраненные координаты с точками 

съемки. Эти координаты можно изменить вручную. Точка 
съемки может иметь более одной координаты из различных 
вычислений. 
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5.7.2.5 Перемещение по деталям ГНСС наблюдений в Survey Explorer 

 

В этой главе рассказывается, как перейти к детализированной странице ГНСС 

наблюдений в Survey Explorer. Не имеет значения, как вы ввели геодезическую 

информацию (в соответствии с 5.7.2.2 Инструмент List Survey objects или 5.7.2.3 List 

Survey objects by Query). 

 

Шаг Действие 

1 Убедитесь что созданный вами список с ГНСС наблюдениями с выборки 
или запроса. 
 

 
 

2 Для детального просмотра отдельных ГНСС наблюдений GNSS, 
выберите пожалуйста нужную линию, нажав на ведущей колонке. 

3 Кликните правой клавишей. 

4 Выберите «Go to Details». 

 
 

 
Для ввода геодезической точки, которая относится к GNSS 
наблюдениям выберите «Go to Survey Points» 

 Для удаления GNSS наблюдения, выделите линию и кликните красное 

перечеркивание . 

 Для создания текстового отчета на основе выделенных данных, 
отметьте необходимые линии и выберите «Survey Object Report…» 

5 Отобразится страница с детальной информацией для выбранных GNSS 
наблюдений. 
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 Измените высоту антенны  
 Измените тип антенны 

 

 

5.7.2.6 Вычисление пост обработки 
Эта часть покажет вам как перейти к вычислению пост обработки в Survey Explorer.  

Следуйте рекомендациям предыдущего EasyIn рекомендующего убеждаться, что 

вычисления доступны. 

 

Шаг Действие 

1 Кликните кнопку List Survey Objects Tool на панели Survey Editor. 
 

 
 

2 Отметьте галочкой GNSS Post Processing и кликните OK. 
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3 Выберите соответствующее вычисление, кликнув на ведущей колонке. 
 

 
 

4 Кликните правой клавишей мыши на номере строки и выберите «Go To 
Details». 
 

 
 

5 Окно вычислений состоит из нескольких закладок. 
 



 

Zeno GIS 
Быстрый старт 110  

 
 

На вкладке General вы можете изменить следующие параметры 
вычислений:  

  
 Cut off Angle (Угол отсечки) 
 Solution Type (Тип решения) 
 GNSS Type (Тип ГНСС) 

 
Во вкладке Baseline вы можете настроить базовые линии.  Это поможет 
вам ответить на вопрос, какая база используется для какого ровера.  
  
На вкладке Points Вы можете просмотреть все для computed points:  

 GNNS Type  
 Solution Type  
 Easting, Northing, Height  
 Position Quality  
 Height Quality  

  
Вы также можете просмотреть unprocessed points:  

 Reference Station  
 GNSS Type  
 Solution Type  
 DOP values  

  
Вкладка Observation разделена на два:  

 Окно базовой стонции (верхнее окно)  
 Окно ровера (нижнее окно) 
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В окне базовой станции вы можете:  
 Установить фильтр для отображения GNNS измерений во 

вкладке  Observation 
 В ручную импортировать базовые данные для пост обработки 

(пост обработка также может быть сделана автоматически во 
время EasyIn) 

  
В окне ровера вы можете:  
  

 Удалить наблюдения  
 Восстановить все удаленные наблюдения  
 Отключить наблюдения   
 Отключить все наблюдения  
 Импортировать данные ровера  
 Установить фильтр отображения ваших ГНСС измерений во 

вкладке наблюдений 

 После редактирования значений в GNSS Post Processing, необходимо их 
пересчитать. Например, после изменения угла отсечки, типа ГНСС и т.д. 
Поэтому просто нажмите кнопку Compute (вычислить) в Survey Explorer. 
 

 
 

Расчет состояния в нижней части окна покажет Вам, если необходим 
перерасчет 
  

 Зеленый цвет состояния  : не нужен 
перерасчет  

 Красный цвет состояния  : необходим 
перерасчет. 
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5.8 Вычисления COGO 
В этой главе вы найдете обзор некоторых построений COGO. Эта глава описывает 

некий рабочий процесс, например обрисовку края дороги. 

 

Шаг Действие 

1 Запустите Zeno Office и откройте проект. Если существующий полигон 
ещё не в проекте, то, пожалуйста, создайте класс полигона под 
названием Land_Parcel. 

2 Увеличьте область в которой вы хотите работать. 

3 Первое вычисление, которое вы будете выполнять это построение 
Direction-Distance. Нажмите на кнопку Direction-Distance на панели 
инструментов Survey Editor. 
 

 
 

4 Появится Survey Explorer со страницей Direction- Distance. 
 

 
 

 
Имеется четыре способа создания информации с карты в конструкциях 
COGO в Zeno Office. Используя эти построения COGO в этой главе, вы 
ознакомитесь со всеми четырьмя методами ввода.  

5 Кликните в From Point  и нажмите Survey Point на карте.  
После этого убедитесь, например, что 'P1.BP1000' появилось в поле 
ввода From Point.  
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6 Курсор переместится в поле ввода Direction и активизирует его. На 
экране должна появиться линия. 

7 Выберите сегмент пространственного объекта в карте для получения 
Direction. Это один из четырех методов ввода для вычисления COGO. 
Так как вы хотите привязать к ребру, убедитесь, что установлена 
привязка на вершине (перейдите Editor > Snapping > Snapping Toolbar). 

 
Для Zeno Office <3.0: перейти на Editor > Snapping: отметьте Land_Parcel - 
Edge. Закройте диалог. Вы можете просто перейти в Snapping  
Environment во время активного вычисления - это не повлияет на 
результат.  
 

 
 

8 Now snap to the Land_Parcel edge as seen in the picture below. The 
Direction could differ about 200 gon, depending on the position of the 
cursor. The length middle of the segment divides the two directions. 
Привяжитесь к краю Land_Parcel, как показано на рисунке ниже. 
Направление может отличаться около 200 угольник, в зависимости от 
положения курсора. Длина середины отрезка делит двух направлениях. 
 

 
 

9 Finally do a left mouse click to get the Direction added to the Survey 
Explorer. Make sure that the direction is not pointing 200 gon to the wrong 
direction. 

10 The cursor is now in the Distance entry box. A circle appears where you can 
drag out a radius representing a distance. 

11 Type in a distance value of 10.00 m. Typing in values is the second method 
of input into a COGO computation page. 

12 Name the Result point e.g. P1.RE1 and press Enter. The computed point 
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should appear on the map.   
 

 
 

13 Save your edits (Editor > Save Edits). 

14 
Press the New Object button   on the Survey Explorer to compute 
another point of the Road_ Edge footprint. 

15 An empty Direction-Distance construction appears in the Survey Explorer. 

16 For the First Point, confirm the suggested point RE1 by pressing Enter. 

17 The cursor moves to the direction entry box. 

18 For this direction, we want to snap to a land parcel feature edge again. You 
want the constructed road to be parallel to the Land Parcel segment, which 
starts from e.g. BP1000 and goes towards the southeast. 
 

 
 

19 Snap to the Land_Parcels segment and do a left mouse-click to confirm the 
selection. Make sure that the direction is not pointing 200 gon to the wrong  
direction. 

20 The focus changes to the Distance entry. Type in a distance of 100 m. 

21 Confirm the suggested Result Point RE2 by pressing Enter. 
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22 Now we want to work with an intersection computation:  
  
Click on the Distance – Distance Intersection Tool. 
 

 
 

23 An empty Distance – Distance Intersection page appears. 

24 Select the First Point: e.g. P1.RE2 by snapping on the point. 

25 The cursor changes to the first Distance entry box.  
Type in the First Distance: 14.142 m. Confirm the typed in value by pressing 
Enter. 

26 The cursor is now in the Second Point entry box. Snap to point e.g. P1.RE3. 

27 The cursor moves to the Second Distance edit box. Get the Distance by 
moving your mouse cursor from e.g. P1.RE3 and snap it to point e.g. P1.RE2. 
This is the third method of input: the selection of a Survey Point, Feature 
Vertex or individual map position you want to use as a second point, to 
receive a Distance (or Direction). 

28 After a left mouse click, the value gets added to the Second Distance entry 
box and the cursor changes to the solution drop-down menu.   

29 Accept right for the solution. 

30 A Result Point gets suggested. Accept it by pressing Enter. 

31 The cursor is now in the Second Point entry box. Snap to point e.g. P1.RE3. 
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6. Zeno Tools   

6.1 Введение 
 

Обзор 

 

Zeno Tools состоит из нескольких приложений, например настройка Zeno 10/15 или 

GG02 plus. 

В зависимости от установки на Zeno или CS25, могут быть использованы следующие 

приложения:    

  

Zeno Tools на Zeno 10/15:  

 Bluetooth Manager для подключения внешних устройств Bluetooth, таких 

как лазерные дальномеры 

 Изменение системных настроек (System Settings), например размера 

шрифтов  

 Добавление новых лицензионных ключей (например новые сервисные 

ключи технического обслуживаня, ключ Glonass для GS05/06, и т.п.)  

 Загрузка новой прошивки для GS05/06 

  

Zeno Tools на CS25:  

 Загрузка новой прошивки для GG02 plus  

  

Zeno Tools на Zeno 5:  

 Менеджер лицензий (License Manager)   

  

  

    Эта глава состоит из трёх частей.   

 6.2 Zeno Tools на Zeno 10/15  

 6.3 Zeno Tools на CS25  

 6.4 Zeno Tools установленный на Zeno 5 
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6.2 Zeno Tools на Zeno 10/15  

6.2.1 Использование System Settings Manager 
 

Обзор 

 

В менеджере настроек системы (System Settings Manager) Вы можете изменить 

размер шрифта, сделать сброс к заводским установкам GS05/06 (сброс удаляет 

альманах и повторно инициализирует насадки), и указать скорость USB. 

 

  
 

Изменение размера системных шрифтов 

 

Этот инструмент используется для установки размера системного шрифта для Zeno. 

Доступны размеры малых, средних, больших шрифтов, и оптимизированных для 

Zeno шрифтов. 

   Пожалуйста, обратите внимание, что использование больших размеров шрифта 

также изменяет размеры диалоговых окон. Некоторые диалоги будут не полностью 

видны. 

 

Шаг Действие 

1 Запустите System Settings Manager на вашем Zeno 10/15 нажав Start > 
Programs > Zeno Tools > System Settings Manager. 

2 Выберите нужный размер текста. 

3 Нажмите OK. Появится диалоговое окно с запросом на перезагрузку 
системы. Нажмите Yes и система перезагрузится с новыми настройками 
размера шрифта. 

 

Изменение настроек USB 

Здесь скорость USB может быть изменена с USB Full Speed до более быстрой USB 

High Speed. Этот параметр является обязательным, так как некоторые компьютеры 

не поддерживают USB High Speed. 
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Шаг Действие 

1 Запустите System Settings Manager на вашем Zeno 10/15 выбрав Start > 
Programs > Zeno Tools > System Settings Manager. 

2 Перейдите в закладку USB Settings. 

3 Выберите желаемую скорость USB. 

4 Нажмите OK. A dialog box will ask you to restart the system. Tap yes and the 
system will restart with the new USB speed setting. Диалоговое окно с 
запросом на перезагрузку системы. Нажмите Да и система 
перезагрузится с новой настройки скорости USB. 

 

Сброс настроек GS05/06  

Функция сброса для GS 05/06 сбрасывает его на заводские установки. Это означает, 

например, что альманах будет удален. Это может быть полезно для более быстрого 

позиционирования Zeno, если он был перемещен на большое расстояние. 

Шаг Действие 

1 Запустите System Settings Manager на вашем Zeno 10/15 нажав Start > 
Programs > Zeno Tools > System Settings Manager. 

2 Перейдите в закладку Reset. 

3 Нажмите кнопку Reset. 

4 Нажмите ОK для закрытия диалогового окна System Settings. 

 

 

 

6.2.2 Использование Firmware Loader на GS05/06  
 

Обзор 

В приложении Firmware Loader, вы можете 

просматривать и загружать новые прошивки для 

GS05/06. 

  

Всегда проверяйте что батарея достаточно 

заряжена во время загрузки микропрограммы. 

Загружая новую прошивку, может потребоваться 

действительный ключ CCP. До выбора и загрузки 

новая прошивка должна быть скопирована на 

Zeno. 

 

 

 

Загрузка прошивки пошагово 

 

Шаг Действие 

1 Загрузите последнюю версию прошивки GS05/06 с сайта  
https://myworld.leica-geosystems.com. 

2 Скопируйте файл прошивки GS05/06 в директорию в Zeno, SD-карту, 
Leica Compact Flash или USB флешку (через ActiveSync или центр 
мобильных устройств, USB Memory Stick или SD). 

3 Запустите  Firmware Loader GS05/06 на вашем Zeno 10/15 нажатием Start 
> Programs > Zeno Tools > GS05/06 Firmware Loader. 

4 Нажмите на значок папки в диалоговом окне загрузчика прошивки, 
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перейдите в директорию, в которую вы скопировали файл прошивки GS, 
выберите его и запустите установку, нажав клавишу Upload. 

 
 

 

 

6.2.3 Использование License Manager 
License Manager 

Пожалуйста, перейдите к главе 1.1.3 Лицензирование. 

 

6.2.4 Использование Bluetooth 
Обзор 

Bluetooth приложение используется для настройки Bluetooth соединения с 

внешними устройствами Bluetooth. Это может быть лазерный дальномер, который 

может быть использован в Zeno Field или компьютер, к которому должны 

передаваться NMEA данные по беспроводной связи. 

Bluetooth Manager настраивает Bluetooth соединение, все необходимые порты и 

службы. Фактическое подключение Bluetooth автоматически устанавливается, как 

только приложение Zeno Field открывает соответствующий COM порт. 

Интерфейс Bluetooth Manager 

 

 
 

Иконка Функция 

 

Показать Bluetooth устройства в радиусе действия. 
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Поиск Bluetooth устройств в радиусе действия. 

 

Остановить поиск Bluetooth устройств. 

 

Зарегистрированные устройства – показать устройства, которые 
уже были подключены ранее. 

 

Локальные службы - используется для предоставления услуг 
удаленным устройствам, например последовательный порт для 
потоковой передачи NMEA к ПК. 

 

Свойства 

 

 

6.2.4.1 Подключение внешнего Bluetooth устройства 
 

Шаг Действие 

1 Запустите Bluetooth приложение на вашем Zeno 10/15 кликнув Start > 
Programs > Zeno Tools > Bluetooth Manager 

2 
Нажмите Search   для поиска Bluetooth устройств в радиусе 
действия. Будут найдены новые устройства. 
 

 
 

 
Совет: Пожалуйста, убедитесь, что Bluetooth на устройствах включен и 
подготовлен для нахождения поиском. 

3 Кликните на новом устройстве для использования и выберите «Pair» для 
его сопряжения с Zeno (совместной работы в паре). 
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4 Введите пароль и нажмите OK. 

 
 

 
Совет: Требуется ли сопряжение или нет, зависит от устройства. 
Пожалуйста, обратитесь к руководству пользователя вашего Bluetooth 
устройства, чтобы узнать требуется ли сопряжение или нет. Также там 
вы должны найти ключ доступа (пароль) к использованию. 

5 Нажмите на новое устройство для использования и кликните  «Open» в 
контекстном меню.  Отобразятся службы устройства. 

6 В этом случае, выберите службу последовательного порта (serial port) и 
нажмите «Connect» в контекстном меню. 
 

 
 

7 Выберите COM порт назначения устройства. В этом случае: COM4 
 

 
 

8 Нажмите OK. 

9 Now the device and the Zeno are connected.  

If you click on Registered devices , you can see all connections to 
devices including the COM port details. 
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10 Сейчас вы можете закрыть  Bluetooth Manager и перейти к Zeno Field. 

11 В Zeno Field откройте Rangefinder Preferences (Установка дальномера). 

12 Выберите соответствующий протокол и COM порт, к которому 
устройство подключено. Имя устройства написано после номера COM 
порта. 
 

 
 

13 Сейчас вы можете работать с подключенным устройством. 
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6.2.4.2 Работа Leica DISTO через Bluetooth используя программное обеспечение DISTO 

Transfer PPC  
  

Обзор 

Очень удобный способ работы через Bluetooth в Leica DISTO является 

использование Leica Transfer PPC. Вы можете скачать его с сайта Leica MyWorld.  

 

Установка DISTO Transfer PPC на ваш Zeno 

 

Шаг Действие 

1 Скопируйте SetupDistoPPC.exe на ПК. Вы можете получить его, 
например, с сайта Leica MyWorld 

2 Подключите Zeno к ПК с помощью ActiveSync или Windows Mobile Device 
Center. 

3 Запустите SetupDistoPPC.exe на ПК. 

4 Выберите язык и кликните OK. Запустится мастер установки DISTO 
transfer PPC Setup. 

5 Кликните «I agree» для подтверждения лицензионного соглашения. 
Начнется установка. 

6 Кликните «Yes» для установки DISTO transfer PPC в стандартной 
директории приложения на Zeno. 

 

 

Первое подключение DISTO к DISTO Transfer PPC 

 

Шаг Действие 

1 Включите DISTO и убедитесь что Bluetooth доступно. 

 
Совет: Нажмите клавишу Bluetooth для включения или отключения 
Bluetooth. 

2 Запустите передачу данных DISTO на Zeno нажатием Start > Programs > 
DISTO transfer. 

3 Выберите нужный язык и нажмите OK. 

4 Появится диалоговое окно с указанием всех активных DISTO в 
диапазоне. 
Выберите DISTO и нажмите OK. 
 

 
 

 
Совет: В следующий раз DISTO transfer PPC будет подключен к DISTO 
автоматически. 

 

 

 

Использование DISTO Transfer PPC для передачи данных в Zeno Field 

 

DISTO Transfer PPC может быть использован для передачи измеренных значений в 

Zeno Field или любое другое приложение. 
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Шаг Действие 

1 Включите DISTO и убедитесь что Bluetooth доступен. 

 
Совет: Нажмите клавишу Bluetooth для включения или отключения 
Bluetooth. 

2 Запустите передачу данных DISTO на Zeno нажав Start > Programs > DISTO 
transfer. 

3 Leica DISTO transfer запустится и подключится к DISTO автоматически. 

4 Рекомендуется использовать следующие параметры: 
 

 
 

5 Кликните в поле, в которое DISTO измерения должны быть введены. 

 
Совет: Вы можете отправить измеренное значение в любое 
редактируемое поле из любого приложения. 
В Zeno Field это может быть либо поле расстояния в точке смещения, 
или поле атрибута, например глубина люка. 

6 Измерьте расстояние с помощью DISTO. 

7 Нажмите клавишу Bluetooth на DISTO для передачи значения в 
выбранное поле. 
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6.3 Zeno Tools на CS25 
 

Обзор 

 

С установленным Zeno Tools на CS25 вы можете загрузить новую прошивку на GG02 

plus.  

Пожалуйста, обратите внимание, что загрузка прошивки возможна только с 

помощью кабеля. 

 
 

Как загрузить прошивку для GG02 plus? 

 

Шаг Действие 

1 Подключите GG02 plus к ПК используя кабель GEV162. 

2 Запустите Firmware Loader Tool на CS25 нажав Start > All Programs > Leica 
Zeno Tools > Firmware Loader GG02 plus 

3 Включите GG02 plus. 

4 Выберите COM порт на CS25 через который подключен GG02 plus.  
Укажите расположение новой прошивки для GG02 plus.   

5 Проверьте номер версии новой прошивки и убедитесь что она выше чем 
текущая на вашей системе. 

6 Кликните «Upload» для обновления. 

7 Кликните «Close» когда загрузка будет завершена. . 
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6.4 Zeno Tools на Zeno 5 
Обзор 

С помощью Zeno Tools установленного на Zeno 5 вы можете лицензировать ваше 

программное обеспечение через License Manager. 

 

 

6.4.1 Использование License Manager 
 

License Manager 

Пожалуйста, перейдите к главе 1.3.3 Лицензирование 
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050050 Алматы, Казахстан 

Тел.: +7 (727) 250-39-54 

Факс: +7 (727) 331-25-70 

E-mail: info@leica-geosystems.kz 
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010011 Астана, Казахстан 

Тел.: +7 (7172) 38-61-70 

Факс: +7 (7172) 38-95-57 
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